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Regulatory Compliance

Thermo Fisher Scientific performs complete testing and evaluation of its products to ensure full compliance with 
applicable domestic and international regulations. When the system is delivered to you, it meets all pertinent 
electromagnetic compatibility (EMC) and safety standards as described below.

EMC Directive 2004/108/EC

EMC compliance has been evaluated by TUV Rheinland of North America.

Low Voltage Safety Compliance

Low voltage safety compliance has been evaluated by TUV Rheinland of North America.

This device complies with Low Voltage Directive 2006/95/EC, harmonized standard EN 61010-1: 2001, 
IEC 61010-1: 2002, UL 61010A-1: 2004, and CAN/CSA 22.2 61010-1: 2004.

Changes that you make to your system may void compliance with one or more of these EMC and safety standards. 
Changes to your system include replacing a part or adding components, options, or peripherals not specifically 
authorized and qualified by Thermo Fisher Scientific. To ensure continued compliance with EMC and safety standards, 
replacement parts and additional components, options, and peripherals must be ordered from Thermo Fisher Scientific 
or one of its authorized representatives.

FCC Compliance Statement

CISPR 11: 1998 EN 61000-4-4: 2004

EN 55011: 1998, A1:1999, A2, 2002 EN 61000-4-5: 2001

EN 61000-3-2: 2000 EN 61000-4-6: 2003

EN 61000-3-3: 1995, A1: 2001 EN 61000-4-11: 2001

EN 61000-4-2: 2001 EN 61326-1: 1997, A1: 1998, A2: 2001, A3: 2003

EN 61000-4-3: 2002 CFR 47: 2007

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO 
THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT CAUSE HARMFUL 
INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED, 
INCLUDING INTERFERENCE THAT MAY CAUSE UNDESIRED OPERATION.



Notice on Lifting and Handling of
Thermo Scientific Instruments

For your safety, and in compliance with international regulations, the physical handling of this Thermo Fisher Scientific 
instrument requires a team effort to lift and/or move the instrument. This instrument weighs 18 kg (40 lbs) and is too 
heavy for one person alone to handle safely.

Notice on the Proper Use of
Thermo Scientific Instruments

In compliance with international regulations: Use of this instrument in a manner not specified by Thermo Fisher 
Scientific could impair any protection provided by the instrument.

Notice on the Susceptibility 
to Electromagnetic Transmissions

Your instrument is designed to work in a controlled electromagnetic environment. Do not use radio frequency 
transmitters, such as mobile phones, in close proximity to the instrument.

For manufacturing location, see the label on the instrument.

CAUTION Read and understand the various precautionary notes, signs, and symbols contained inside 
this manual pertaining to the safe use and operation of this product before using the device.



WEEE Compliance

This product is required to comply with the European Union’s Waste Electrical & Electronic 
Equipment (WEEE) Directive 2002/96/EC. It is marked with the following symbol:

Thermo Fisher Scientific has contracted with one or more recycling or disposal companies in each 
European Union (EU) Member State, and these companies should dispose of or recycle this product. 
See www.thermo.com/WEEERoHS for further information on Thermo Fisher Scientific’s compliance 
with these Directives and the recyclers in your country.

WEEE Konformität

Dieses Produkt muss die EU Waste Electrical & Electronic Equipment (WEEE) Richtlinie 2002/96/EC 
erfüllen.  Das Produkt ist durch folgendes Symbol gekennzeichnet:

Thermo Fisher Scientific hat Vereinbarungen mit Verwertungs-/Entsorgungsfirmen in allen EU-
Mitgliedsstaaten getroffen, damit dieses Produkt durch diese Firmen wiederverwertet oder entsorgt 
werden kann. Mehr Information über die Einhaltung dieser Anweisungen durch Thermo Fisher 
Scientific, über die Verwerter, und weitere Hinweise, die nützlich sind, um die Produkte zu 
identifizieren, die unter diese RoHS Anweisung fallen, finden sie unter  www.thermo.com/
WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS


Conformité DEEE

Ce produit doit être conforme à la directive européenne (2002/96/EC) des  Déchets d'Equipements 
Electriques et Electroniques (DEEE). Il est marqué par le symbole suivant:

Thermo Fisher Scientific s'est associé avec une ou plusieurs compagnies de recyclage dans chaque état 
membre de l’union européenne et ce produit devrait être collecté ou recyclé par celles-ci. Davantage 
d'informations sur la conformité de Thermo Fisher Scientific à ces directives, les recycleurs dans votre 
pays et les informations sur les produits Thermo Fisher Scientific qui peuvent aider la détection des 
substances sujettes à la directive RoHS sont disponibles sur www.thermo.com/WEEERoHS. 

http://www.thermo.com/WEEERoHS
http://www.thermo.com/WEEERoHS
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Preface

About This Guide
This guide describes how to control the UV1000 and UV2000 detectors from the keypad and 
how to maintain the detectors for optimal performance.

Safety and Special Notices
Make sure you follow the precautionary statements presented in this guide. The safety and 
other special notices appear in boxes.

CAUTION  A caution alerts you to situations that could result in personal injury. It also 
tells you how to avoid them.

CAUTION  This icon alerts you to the presence of high voltage and to the potential injury 
that could occur from electrical shock were you to come in contact with a specific 
instrument area or component. It also tells you how to avoid contact with the high-voltage 
areas in your instrument.

CAUTION  This icon alerts you to potential injury that could occur from coming in 
contact with a heated surface or area on or in an instrument. It also tells you how to avoid 
contact with the heated surfaces in your instrument.

IMPORTANT  Alerts you to the correct operating or maintenance procedures needed to 
prevent equipment or data damage. They also alert you to important exceptions, side 
effects, or unexpected occurrences that might result from certain action(s).

Tip  Tips call out general rules or shortcuts. They specify ways to obtain the best 
performance and results from your instrument.
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Contacting Us

There are several ways to contact Thermo Fisher Scientific. 

To contact Technical Support

Find software updates and utilities to download at www.mssupport.thermo.com.

To contact Customer Service for ordering information

To suggest changes to documentation or to Help

• Fill out a reader survey online at www.thermo.com/lcms-techpubs.

• Send an e-mail message to the Technical Publications Editor at 
techpubs.finnigan-lcms@thermofisher.com.

CAUTION  Highlights hazards to humans, property, or the environment. Each 
CAUTION notice is accompanied by an appropriate CAUTION symbol. 

Phone 800-685-9535
Fax 561-688-8736
E-mail TechSupport.C+MS@thermofisher.com
Knowledge base www.thermokb.com

Phone 800-532-4752
Fax 561-688-8731
Web site www.thermo.com/finnigan

mailto:TechSupport.C+MS@thermofisher.com
http://www.thermokb.com
http://www.mssupport.thermo.com
http://www.thermo.com/finnigan
http://www.thermo.com/lcms-techpubs
mailto:techpubs.finnigan-lcms@thermofisher.com
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Introduction

This chapter provides you with the three basic rules you will need for using your Thermo 
Scientific SpectraSYSTEM UV/Vis detector. It also introduces you to the instrument's 
command center and describes the conventions we will use in this manual. 

Before you start this chapter, be sure to read the Safety Information section beginning on page 
v of this manual and Chapter 6, “Installation and Specifications.” 

Throughout our explanations, we encourage you to explore the general architecture of the 
instrument's menus and screens. Use the Menu Trees in Chapter 7, “Menu Reference,” as 
your guide if you want.

Learning Your Way Around
It's easy to learn your way around a SpectraSYSTEM detector. Just remember these three 
rules:

1. The arrow keys , , ,  move the cursor in the direction printed on the key. 

2. The shape of the cursor determines how you make a selection:

• If a triangular Cursor appears, press the [ENTER] key.

• If a blinking square cursor  appears, press the + or - keys to change values. 
Depending on the field, you will scroll up or down through preset choices, or change 
alphanumeric entries one letter or digit at a time.

Contents

• Learning Your Way Around

• Instrument Control

• Manual Conventions

• What's Next?

Tip  Press [MENU] to jump quickly to the top of the menu structure.
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3. There are four ways to accept (and automatically save) an entry. Just move the cursor out 
of the field by any of the following methods: 

• Pressing the [ENTER] key

• Using the arrow keys

• Pressing the [MENU] key

• Pressing the [STATUS] key
 

Visual Clues

The following conventions are used on the detector's display:

1. Top-level menu choices are displayed in all-capital letters. 

2. A field's square cursor changes to an underscore cursor when you're scrolling through 
preset choices or entering numerical values and characters.

3. A solid down-arrow  on the right side of some displays indicates that the current menu 
continues on additional screens. To access additional menu lines, press .

4. The last line of a longer menu is frequently a blank display line (without a solid 
down-arrow).

Instrument Control
Take a look at the keypad and two-line display located on the front panel (Figure 1). This is 
the command center from which you'll access menus and control the instrument's operations. 
A brief explanation of the keys and the main menus and screens follows. 

Tip  You won't be able to leave a menu if errors are present or if you haven't filled in all the 
necessary entries.
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Figure 1. The detector's command center

Keypad

The keypad of each SpectraSYSTEM instrument consists of twelve keys. Four keys directly 
control the instrument's operation: RUN, STOP, STATUS, and on the detector, a blank key 
called ZERO. The remaining keys either access commands (MENU and ENTER), or are 
used to set parameters and move around the display ( , , , , + , - ). The function of 
each is explained below.

STOP

D
ET

\Z
00

8\
FM

RUN STATUS MENU

ENTER

SpectraSYSTEM UV2000

STOP

ZERO

Keys Functions

RUN Pressing the [RUN] key starts a run.The detector must be in the 
READY state (or QREADY if a queue is loaded), indicating that the 
detector is stabilized and waiting to begin a run.

STOP Pressing the [STOP] key halts a run, stops the internal clock, and 
returns the detector to a READY state. If a wavelength program is 
operating, pressing the [STOP] key halts the program and returns the 
detector to its initial conditions.

STATUS Pressing the [STATUS] key displays the Status Screen (Figure 1). From 
the Status Screen you can monitor the run in progress. You can also 
access the Status Menu. See page 5 for more information.
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Menus, Screens, and Messages

Your detector's display can show you three kinds of information: menus, screens, and 
messages. Menus require you to make selections or enter specific values. Screens display 
information that cannot be edited. Messages confirm actions and point out errors. The Menu 
Tree in Appendix B outlines the structure and content of the menus and screens.

Menus

• Main Menu

The Main Menu is the top level of the menu structure. In the UV1000, (Figure 2) the 
Main Menu gives you access to four other menus: FILE, COMMANDS, OPTIONS, 
and TESTS. In the UV2000, there is and additional menu choice, QUEUE (Figure 3). 
To see the Main Menu, press [MENU] at any time.

ZERO The unlabeled key is the only variable key in the whole 
SpectraSYSTEM family. On the detector, the blank key is the [ZERO] 
key. The key's name appears on the nameplate below the key.

Pressing the [ZERO] key resets the detector output to zero volts, plus 
or minus any offset.

MENU Pressing the [MENU] key displays the Main Menu (Figure 1 and 
Figure 2). See page 4 for more information.

ENTER Pressing the [ENTER] key accepts a selected choice or menu entry. 
The [ENTER] key also advances the cursor to a new field, either on 
the same line of the display or in the line below. 

, , , Pressing any arrow key (up, down, left, or right) moves the cursor in 
the direction indicated on the key. The up- and down-arrow keys also 
move the cursor between menus and displays.

+ and - Pressing the + and - keys scrolls you through a field's available choices 
or changes the value of alphanumeric entries. Holding down either key 
will continuously scroll the list of choices forward or backward until 
you release the key.

In fields that require numerical entries, the value of each digit is 
increased or decreased by one unit each time you press the + or - key. 
In fields that accept either numeric or character entries, such as the 
File Name field, the + and - keys scroll through the alphabet from 
A to Z, then through the numbers 0 to 9, and finally to a slash, 
hyphen, and blank space.

In other fields, the + key advances you through a preset list of choices 
while the - key takes you back through the list.

Keys Functions



 1 Introduction
Instrument Control

Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 5

Figure 2. The UV1000's Main Menu

Figure 3. The UV2000's Main Menu

From the UV1000's and the UV2000's File(s) Menu you can edit, load, or delete files. 
The UV2000 also lets you copy files. The Commands Menu lets you insert an event mark 
onto your chromatogram, short outputs, or shut down the detector. The Tests Menu lets 
you run built-in instrument tests and diagnostics. In the Options Menu, you can set up 
or change your instrument's configuration. From the Queue Menu you can edit or 
change the order of files in the sample queue. Refer to Chapters 3, 4, 5, and Appendix B 
for more information on any of the instrument's menus.

Screens

• Status Screen

The Status Screen (Figure 4) displays the detector status, wavelength setting(s), and the 
absorbance reading. It automatically appears whenever the instrument is powered on or 
the [STATUS] key is pressed. No entries are made on the Status Screen.

Figure 4. The Status Screen

• Status Menu

Just below the Status Screen is the Status Menu. To access the Status Menu, press the 
down-arrow key from the Status Screen. The Status Menu lets you review and edit run 
parameters during a run. Chapter 3 discusses the Status Menu in more detail.

Messages

There are three different kinds of messages that can appear on your detector's display: user 
messages, confirmation messages, and error messages.

• User Messages

User messages, indicated on the display by double asterisks, tell you about an existing 
instrument condition or ask for further actions. Some of these will only appear on the 
display for three seconds. An example of a message requiring further action is shown in 
Figure 5.
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Figure 5. An example of a user message

• Confirmation Messages

Confirmation messages (Figure 6), also indicated on the display by asterisks, appear for 
one second after an operation has been carried out successfully. 

Figure 6. An example of a confirmation message

• Error Messages

Error messages (Figure 7), indicated on the display with capital letters and exclamation 
points, are shown whenever an undesirable condition exists that prevents the instrument 
from carrying out an operation. Error messages remain on the display until you press a 
key.

Figure 7. An example of an error message

Manual Conventions
This manual uses several conventions. Among them are menu displays, text conventions 
(brackets, slashes, and so on), and standard words. 

Displays

Figure 8 shows how we depict the two-line display. Note that, in menu illustrations, the 
triangular cursor location is indicated by a caret (>).

Figure 8. A two-line menu display

Frequently the two lines shown on the display are only part of a longer menu. In this manual, 
menus having more than two lines are represented as in Figure 9. 
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Figure 9. A menu longer than two lines

Text

Three typographic conventions are used to differentiate between keys, menus, and fields.

• Brackets

Brackets, [ ], indicate instrument keys. 
For example: Press [MENU].

• Slashes

Slashes, / /, are used around menu choices. 
For example: From the Main Menu, select /FILES/.

• Capitalization

Capitalization is used to make field and menu names appear just as they do on the 
display. Generally, the first letters of field names are capitalized. 
For example: Select /FILES/, /Copy/, Copy File #.

Standard Words

We have also standardized the meanings of two words: "select" and "enter." 

• select

The word "select" is used when you need to choose from among available options. For 
example, to "select" a particular menu choice, you would move the cursor to the 
appropriate choice and press [ENTER]. To "select" a field entry, move the cursor to the 
appropriate field and use the + and - keys to scroll to the desired preset value. 

• enter

The word "enter" is used when you need to specify individual alphanumeric digits. To 
"enter" a particular value, move the cursor to the desired field and use the + and - keys to 
increment or decrement each digit in the field until the desired value or letter appears. 

What's Next?
Now you're ready to try the practice example in Chapter 2, “Quick Example.” 
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Quick Example

In Chapter 1, you read about the three easy rules for using your detector's command center 
and some of its menus and screens. In this chapter, you will find an example procedure that 
shows you how the rules and keys actually work as you move through the various menus. 

Once the detector is installed in your chromatographic system according to the procedures 
described in Chapter 6, “Installation and Specifications,” and you have completed the 
Installation Checklist, you are ready to begin your quick example.

This quick example uses only a fraction of the features available on your detector and is 
included only as a first step in becoming familiar with your new instrument. 

After experimenting with this example, you'll want to turn to Chapter 3, “Basic Operations,”  
and Chapter 4, “Advanced Operations,” which cover the detector's basic and more advanced 
operations. It is in those chapters that you'll learn about the full capabilities of your detector. 

First though, to give you a general understanding of the capabilities and design of the 
detectors, we will briefly describe the features and benefits of the UV1000 and UV2000 here.

The UV1000 detector is a time-programmable, variable-wavelength UV/Vis 
(ultraviolet/visible) absorbance detector. It operates in single-wavelength mode in either the 
UV range (using a deuterium lamp), or in the visible range (with an optional tungsten lamp). 
The UV1000's optical system has a novel, high light-throughput design that provides high 
sensitivity detection along with maximal application versatility. The UV1000 detector can be 
upgraded to a UV2000.

The UV2000 detector is a full-featured, time-programmable, dual-wavelength UV/Vis 
absorbance detector. It operates in both single- and dual-wavelength modes in the UV and 
visible ranges. The UV2000 offers the same optical system design as the UV1000. In addition 
to the features of the UV1000, the UV2000 also offers spectral scanning, a Develop File (for 
method development), multiple file storage, a Queue feature (that allows you to link files), 
and more.

Contents

• UV1000 Example

• UV2000 Example

• What's Next?
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UV1000 Example
In this example, we will show you how to prepare an edit file and how to load the edit file into 
the detector's run file. After a practice run, we will add a stop-time.

Startup

Set the power switch located on the detector's rear panel to On. After a series of power-up 
tests, the Status Screen (Figure 10) appears on the display. (We will discuss the Status Screen 
after you have set up your operating parameters.)

Figure 10. The UV1000's Status Screen

Setting Parameters

To set your parameters, you need to prepare an edit file. 

To access the Edit Menu and prepare the file

1. Press the [MENU] key. The detector's Main Menu appears on the screen (Figure 11).

Figure 11. The UV1000's Main Menu 

2. Now select /FILES/ to display the Files Menu (Figure 12).

Figure 12. The UV1000's Files Menu

3. Select /Edit/ to display the Edit Menu (Figure 13).

Figure 13. The UV1000's Edit Menu

Tip  You may wish to keep the Menu Tree in Chapter 7, “Menu Reference,” on hand as 
you work through this example. If you lose your place at any time, you can:

1. Press the  key to move back to a previous screen.

2. Or, press [STATUS] to return to the Status Screen and retrace your steps.
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Wavelength

You use the Wavelength program to set the monitoring wavelength. Wavelength is an example 
of a field that requires a numeric entry.

To set the wavelength

1. From the Edit Menu (Figure 13), select /Wavelength Program/ to display the Wavelength 
Program (Figure 14).

Figure 14. The UV1000's wavelength program

2. Using the + and - keys, edit the wavelength field to the desired setting for your analysis. 
Remember that each digit must be edited individually.

3. Press [ENTER] to accept the new wavelength setting.

Range

Range is an example of a field that has a preset list of choices. 

To set the range

1. Select /Options/ from the Edit Menu (Figure 13) to display the Options Menu 
(Figure 15).

Figure 15. The UV1000's Options Menu

2. Scroll down in the Options Menu and move the cursor to Range 1 using the  key.

3. Using the + or - key, select the desired setting from the list of choices.

4. Press [ENTER] to accept the new range setting.

We will use the rise time and autozero time default settings for this example. You will learn 
more about setting these parameters in Chapter 3, “Basic Operations.” 
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Loading the File

You are now ready to load the settings from the edit file into the detector's operating 
parameters (its run file). 

To load the file

1. Return to the File Menu (Figure 12) using the  key.

2. Select /Load/. The screen in Figure 16 appears.

Figure 16. The Load File command

3. Press ENTER to execute. The confirmation message shown in Figure 17 appears for one 
second.

Figure 17. The file-loaded message

You are automatically returned to the Status Screen and are ready to run your detector.

A Practice Run

Now you're ready for a practice run. Note that the Status Screen (Figure 10) now displays 
your wavelength setting, the detector's status, and the absorbance reading. If the Status reads 
READY, the required lamp is lit; if it reads NRDY (Not Ready), there is an error or the lamp 
isn't lit; and if it reads UVW, the ultraviolet (D2) lamp is still warming up.

When the baseline is stabilized:

1. Press the [ZERO] key to zero the detector's analog output signal.

2. Inject your sample.

During setup, you may have noticed that there was no stop-time entered in the detector's 
parameters. In this case, the detector stays in the READY state and continually monitors the 
column eluant. You do not need to manually start or stop a run with this set-up.

Adding a Stop-Time

To add a stop-time, you need to modify the detector's operating parameters as follows. We 
will then show you how to start and stop a run using the new setting.

To add a stop-time

1. From the Status Screen, press the  key to move down to the Status Menu (Figure 18), 
which is the programming area below the Status Screen. The cursor appears on the "tens" 
digit of the wavelength value.
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Figure 18. The UV1000's Status Menu

2. Using the  key, move the cursor to the blank line below the 0.00 time line and press +. 
This adds a second line, with a time of 1.00 and the same wavelength setting as the first. 
Change 1.00 to the desired stop-time for the run, and leave the wavelength unchanged.

3. To save your edits, scroll down to the words "Save File" which now appear below Range, 
and press ENTER. The confirmation message shown in Figure 19 appears and you are 
automatically returned to the Status Screen.

Figure 19. The file-saved message

Running with a Stop-Time

Now that you have entered a stop-time, you will need to start the run with each injection.

To start the run

1. Zero the detector's analog output signal by pressing the [ZERO] key.

2. When the detector is stabilized, inject your sample and press [RUN].

Notice that Status now shows the run time. If you wish to stop your run before the set 
stop-time, press [STOP].
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UV2000 Example
In this example, specifically designed for the UV2000, we will show you how to prepare a file 
and how to load it into the detector's operating parameters. After a practice run, we will add a 
stop-time. To keep the instructions simple, we will use the single-wavelength mode.

Startup

Set the power switch located on the detector's rear panel to On. After a series of power-up 
tests, the Status Screen (Figure 20) appears on the display. (We will discuss the Status Screen 
after you have set up your operating parameters.)

Figure 20. The UV2000's Status Screen

Setting Parameters

To set your parameters, you need to prepare an edit file. 

To access the Edit Menu and prepare the file

1. Press the [MENU] key. The detector's Main Menu appears on the screen (Figure 21).

Figure 21. The UV2000's Main Menu

2. Now select /FILES/ to display the Files Menu (Figure 22).

Figure 22. The UV2000's Files Menu

Tip  You may wish to keep the Menu Tree in Chapter 7, “Menu Reference,” on hand as 
you work through this example. If you lose your place at any time, you can:

1. Press the  key to move back to a previous screen.

2. Or, press [STATUS] to return to the Status Screen and retrace your steps.
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3. Select /Edit/ to display the Edit Menu (Figure 23).

Figure 23. The UV2000's Edit Menu

For this example, we will use a file designation of 1 and leave the File Name field blank.

Wavelength

Wavelength is an example of a field that requires a numeric entry. 

To set the wavelength

1. From the Edit Menu (Figure 23), select /Wavelength Program/ to display the Wavelength 
Program (Figure 24).

Figure 24. The UV2000's wavelength program

2. Scroll down to the wavelength field.

3. Using the + and - keys, edit the wavelength field to the desired setting for your analysis. 
Remember that each digit must be edited individually.

4. Press [ENTER] to accept the new wavelength setting.
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Range

Range is an example of a field that gives you a preset list of choices. Note that Range 1 and 2 
correspond to Analog Outputs 1 and 2 on the rear panel of your detector. 

To set the range

1. Select /Options/ from the Edit Menu (Figure 23) to display the Options Menu 
(Figure 25).

Figure 25. The UV2000's Options Menu

2. Scroll down in the Options Menu and move the cursor to Range 1 using the  key.

3. Using the + or - key, select the desired setting from the list of choices.

4. Press [ENTER] to accept the new Range 1 setting.

We will use the rise time, autozero time, and range 2 default settings for this example. You will 
learn more about setting these parameters in Chapter 3, “Basic Operations.” 

Loading the File

You are now ready to load the settings from File 1 into the detector's operating parameters. 

To load the file

1. Return to the Files Menu (Figure 22) by pressing either the [ENTER] or  key.

2. Select /Load/. The screen in Figure 26 appears.

Figure 26. The Load File command

2. You will be able to select from among several files in the Load File field. Depending on 
whether or not your detector has ever been used before, these files will either contain 
previously stored settings or default settings. Use the + and - keys to scroll through 
available choices. When the file you want to load appears (we're using the default settings 
for this example), press [ENTER] to execute the load command.
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3. The confirmation message shown in Figure 27 appears for one second, after which you 
are automatically returned to the Status Screen.

Figure 27. The file-loaded message

A Practice Run

Now you're ready for a practice run. Note that the Status Screen (Figure 20) now displays 
your wavelength setting, the detector's status, and the absorbance reading. If the Status reads 
READY, the required lamp is lit; if it reads NRDY (Not Ready), there is an error (for example, 
you may have chosen a wavelength outside the selected lamp's range) or the lamp isn't lit; and 
if it reads UVW, the ultraviolet (D2) lamp is still warming up.

When the detector is stabilized:

1. Press the [ZERO] key to zero the detector's analog output signal.

2. Inject your sample.

During setup, you may have noticed that there was no stop-time entered in the detector's 
parameters. In this case, the detector stays in the READY state and continually monitors the 
column eluant. You do not need to manually start or stop a run with this set-up.

Adding a Stop-Time

To add a stop-time, you need to modify the detector's operating parameters. We will then 
show you how to start and stop a run using the new setting.

To add a stop-time

1. From the Status Screen, press the  key to move down to the Status Menu (Figure 28), 
which is the programming area below the Status Screen.

Figure 28. The UV2000's Status Menu

2. Using the  key, move the cursor to the blank line below the 0.00 time line and press +. 
This adds a second line, with a time of 1.00 and the same wavelength setting as the first. 
Change 1.00 to the desired stop-time for the run, and leave the wavelength unchanged.
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3. To save your edits, scroll down to the words "Save File" which now appear below Range 2, 
and press [ENTER]. The confirmation message shown in Figure 29 appears and you are 
automatically returned to the Status Screen.

Figure 29. The file-saved message

Running with a Stop-Time

Now that you have entered a stop-time, you will need to start the run with each injection.

To start the run

1. Zero the detector's analog output signal by pressing the [ZERO] key.

2. When the detector is stabilized, inject your sample and press [RUN].

Notice that Status now shows the run time. If you want to stop your run before the set 
stop-time, press [STOP].

What's Next?
Once you have completed this example and are comfortable with the keypad and display, 
proceed to Chapter 3, “Basic Operations,” to learn more about your detector.
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3

Basic Operations

This chapter provides step-by-step instructions for the most frequently used detector 
operations, including setup and run procedures for single- and dual-wavelength modes, 
detector file management and protection, and analog output operations. 

You should be aware that your display's values might differ from those presented in this 
manual, especially if the detector has been previously programmed.

Before you begin this chapter, your detector should be installed in a chromatographic system 
(see Chapter 6, “Installation and Specifications,” ) and you should have completed the 
Installation Checklist. We also recommend that you review Chapter 1, “Introduction,” which 
includes general instructions for using the detector keypad.

Contents

• UV1000, Single-Wavelength Operation

• UV2000, Single- and Dual-Wavelength Operation

• More About UV2000 Files

• UV1000 Analog Signals

• UV2000 Analog Signals
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UV1000, Single-Wavelength Operation
The UV1000 uses a standard deuterium lamp to operate in a single-wavelength mode in the 
ultraviolet (UV) range. Adding an optional tungsten lamp increases the detector's capabilities 
to the visible (Vis) range.

To perform a single-wavelength operation, you first enter the desired detector parameters into 
an edit file. You then load the edit file into the run file, which contains the detector's current 
operating parameters. These instructions will show you how to start and stop a run, and how 
to modify the detector's operating parameters.

This section contains the following topics:

• Setting Parameters

• Running Your Detector

• Changing Run Parameters

• Deleting the File

Setting Parameters

You set up the UV1000's parameters by using the File Menu to prepare an edit file. You then 
load the edit file into the run file.

To access the File Menu, first press [MENU]. The Main Menu appears on the screen. From 
the Main Menu, select /FILE/. The menu shown in Figure 30 will appear.

Figure 30. The UV1000's Files Menu

From the File Menu, select /Edit/ to display the Edit Menu. The Edit Menu (Figure 31) 
selections are Wavelength Program, which contains time and wavelength fields, and 
Options, which contains the Rise Time, Autozero Time, and Range fields. 

Figure 31. The UV1000's Edit Menu

Wavelength Program

Select /Wavelength Program/ from the Edit Menu. The Wavelength Program is a Table 
containing the Time and Wavelength fields (Figure 32).
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Figure 32. The UV1000's Wavelength Program 

In the single-wavelength mode, you can operate with either a one-line or a two-line 
wavelength program. Using a one-line program, the detector is always in the READY state 
and you can continually monitor the baseline. Using a two-line program, you can use a 
stop-line and you can start and stop the detector during a chromatographic run. (Stop-lines 
are useful, for example, in an automated series of runs where you want to autozero the 
detector's baseline after each injection.)

For a one-line program, enter the wavelength(s) for your analysis in the Wavelength field that 
corresponds to the time of 0.00.

For a two-line program, add an additional line (the stop-line) by scrolling down to the blank 
line below the time 0.00 line and pressing +. The second line will automatically have a time 
setting of 1.00 and the same wavelength setting(s) as the first. Change 1.00 to the desired 
stop-time for the run, and leave the wavelength value unchanged.

An example of a two-line wavelength program for a nine-minute run at 283 nm is shown in 
Figure 33.

Figure 33. An example of a two-line wavelength program with a programmed stop-time
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Options Menu

Select /Options/ from the Edit Menu to display the Options Menu (Figure 34). Use this 
menu to set the detector's rise time, autozero time, and range.

Figure 34. The UV1000's Options Menu

• Rise Time

This field controls the detector's response time. Rise time is inversely proportional to the 
amount of baseline noise. For example, the longer the rise time, the less noise detected. 
The one-second default value is appropriate for most applications.

• Autozero Time

This parameter tells the detector when to perform an automatic zero of the baseline. If 
you do not wish to set an autozero and you are using a stop-line in your wavelength 
program, simply set the autozero time to a value greater than your stop-time.

• Range

We recommend a range of 1.0 when you are using an integrator or data system.

Loading the Edit File

When you are ready to load the settings from the edit file into the detector's run file, select 
/Load/ from the File Menu. The screen will display the words "Load File." Press ENTER to 
accept the settings. The confirmation message shown in Figure 35 will appear for one second. 
You are then returned to the Status Screen.

Figure 35. The file-loaded message

Tip  To minimize baseline noise while retaining maximum resolution, select a rise time 
that is at least one-tenth of the peak width at the base of the narrowest peak of 
interest.

Tip  It is good practice to zero the detector automatically at the start of each run. This 
will keep the detector output in range throughout an automated series of runs.

Tip  It is good practice to zero the detector automatically at the start of each run. This 
will keep the detector output in range throughout an automated series of runs.
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Running Your Detector

Once you've set your detector parameters in the edit file and have loaded the parameters into 
the run file, you're ready to run your analysis. First, check the detector's status by viewing the 
Status Screen. If you're using a stop-line in your wavelength program, you will start and stop 
the run with each injection.

Status Screen

You can check the detector's status, wavelength setting, and absorbance reading from the 
Status Screen (Figure 36). To access the Status Screen, press [STATUS]. 

Figure 36. The UV1000's Status Screen 

If the Status reads READY, the detector is stabilized and ready to run. If NRDY appears, the 
detector's lamps might need additional time to warm up, or a wavelength outside the selected 
lamp's range might have been chosen. 

Inject your Sample

When the detector is stabilized and you are ready to inject your sample, first manually zero the 
detector by pressing the [ZERO] key. If you are not using a stop-line in the wavelength 
program, the detector remains in the READY state throughout your chromatographic runs. If 
you are using a stop-line, you must start and stop the run with each injection, following the 
procedures below.

Starting a Run

If you are using a stop-line in your wavelength program, you need to start the run with each 
injection. There are two ways to start a run using the UV1000.

• Manually, by pressing [RUN] each time you make an injection.

• Automatically, by interfacing the detector with a remote run-signal from the injector (see 
Chapter 6, “Installation and Specifications,” for details). In this scenario, a signal that is 
equivalent to pressing RUN is automatically sent from the injector to the detector with 
each injection.

During the run, you can monitor the run time from the Status Screen.
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Stopping a Run

There are two ways to stop a run:

• Manually, by pressing [STOP] before the programmed stop-time.

• Automatically, by allowing the run to finish at the programmed stop-time.

In either case, the detector returns to its READY state.

Changing Run Parameters

There are two ways to change the detector's run parameters:

• You can use the Files Menu and follow the procedures outlined under “Setting 
Parameters” on page 20.

• Or you can use the Status Menu, which is the programming area below the Status Screen.

Each method has a distinct advantage. Programming in the Status Menu allows you to change 
the detector's current operating parameters, even while the detector is running. Programming 
in the Files Menu allows you to prepare an edit file containing the changes without altering 
the current detector settings. The file can then be loaded later.

Status Menu

From the Status Screen, scroll down to the Status Menu (Figure 37). The Status Menu 
contains the Wavelength Program, Rise Time, Autozero Time, and Range.

Figure 37. The UV1000's Status Menu 

The parameters are set using the same instructions given under Wavelength Program and 
Options Menu on page 22.

When you use the Status Menu to change the UV1000 settings, each change is effective 
immediately upon leaving the field.

Notice the words "Save File" below the Range field. Press [ENTER] when the cursor is in the 
Save File field to save the new settings to the run file. The confirmation message shown in 
Figure 38 will appear briefly.
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Figure 38. The File Saved message

 

To return to your previous setting without saving the new ones, do not press [ENTER]. 
Instead, you can reenter the unaltered file, as follows:

1. Press [MENU].

2. Select /FILE/.

3. Select /Load/.

4. The words "Load File" will appear on the screen. Press [ENTER].

A confirmation message (Figure 35) will appear for one second. You are then returned to the 
Status Screen, and all settings will contain their original values.

Deleting the File

To delete the edit file, select /Delete/ in the File Menu. The words "Delete File" will appear on 
the screen. When you press [ENTER], the confirmation message shown in Figure 39 appears 
briefly, and the display returns to the File Menu. The edit file parameters return to their 
default settings.

Figure 39. The File- Deleted message

IMPORTANT  When you change the detector settings from the Status Menu, the contents 
of the edit file do not change. Only the run file values are modified.
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UV2000, Single- and Dual-Wavelength Operation
You can operate the UV2000 in either a single- or a dual-wavelength mode. In the 
dual-wavelength mode, the detector simultaneously monitors two wavelengths in either the 
UV range or the visible range in a single run.

To perform a single- or dual-wavelength operation, you need to be able to identify and enter a 
file, load that file into the detector's current operating parameters, and start and stop a run. 
This section will also show you how to modify the detector's current operating parameters. 

This section contains the following topics:

• Setting Parameters

• Loading a File

• Running Your Detector

• Changing Run Parameters

• Status Menu

• Saving the File

Setting Parameters

Before you set any detector parameters, you need to access the Files Menu to identify the file 
you want to edit. 

To access the Files Menu, first press [MENU]. The Main Menu appears on the screen. From 
the Main Menu, select /FILES/. The menu shown in Figure 40 will appear.

Figure 40. The UV2000's Files Menu

Select /Edit/ from the Files Menu to display the Edit Menu (Figure 41). 

Figure 41. The UV2000's Edit Menu



 3 Basic Operations
UV2000, Single- and Dual-Wavelength Operation

Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 27

File Identification

Enter the number of the file you want to edit in the Edit File field. The UV2000 can store up 
to four files in memory, so file numbers from 1 to 4 are allowed. You can also enter a name of 
up to eight characters in the File Name field. 

While in the Edit File, you will see file choices of "S" and "D" that represent the Scan and 
Develop files, respectively. These files are some of the UV2000's advanced features that you 
will learn about in Chapter 4, “Advanced Operations.” 

Wavelength Program

From the Edit Menu, select /Wavelength Program/. The Wavelength Program designates 
dual- or single-wavelength operation, and also contains a Table of time and wavelength. A 
wavelength program for dual-wavelength operation appears in Figure 42.

Figure 42. The UV2000's Wavelength Program in dual-wavelength mode

Select Single, Dual (190-450), or Dual (366-700) in the Program field. The Table for time 
and wavelength(s) will appear. (For single-wavelength operation, there is only one wavelength 
field.)

You can operate with either a one-line or a two-line wavelength program. Using a one-line 
program, the detector is always in the READY state and you can continually monitor the 
chromatographic eluant. Using a two-line program, you can use a stop-line and you can start 
and stop the detector during a chromatographic run. (Stop-lines are useful, for example, in an 
automated series of runs where you want to autozero the detector's baseline after each 
injection.)

For a one-line program, enter the wavelength(s) for your analysis in the 1 and 2 (or 
Wavelength) fields that correspond to the time of 0.00.

For a two-line program, add an additional line (the stop-line) by scrolling down to the blank 
line below the time 0.00 line and pressing +. The second line will automatically have a time 
setting of 1.00 and the same wavelength setting(s) as the first. Change 1.00 to the desired 
stop-time for the run, and leave the wavelength value(s) unchanged.

An example of a dual-wavelength, nine-minute run at 254 and 283 nm is shown in Figure 43.
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Figure 43. A wavelength program with a programmed stop-time

Options

Select /Options/ from the Edit Menu to display the Options Menu (Figure 44). Use this 
menu to set the detector's rise time, autozero time, and ranges.

Figure 44. The UV2000's Options Menu

• Rise Time

This field controls the detector's response time. Rise time is inversely proportional to the 
amount of baseline noise. For example, the longer the rise time, the less noise detected. 
The one-second default value is appropriate for most applications.

• Autozero Time

This parameter tells the detector when to perform an automatic zero of the baseline. If 
you do not want to set an autozero and you are using a stop-line in your wavelength 
program, set the autozero time to a value greater than your stop-time.

• Range 1 and 2

These parameters range the signal from Analog Output 1 and Analog Output 2 (shown as 
ANLG 1 Output and ANLG 2 Output on the detector's rear panel). Set each range to an 
appropriate full-scale absorbance for your sample. For more information on the use of 
ranges and analog outputs, see page 36 and page 90.

Tip  To minimize baseline noise while retaining maximum resolution, select a rise time 
that is at least one-tenth of the peak width at the base of the narrowest peak of 
interest.

Tip  It is good practice to zero the detector automatically at the start of each run. This 
will keep the detector output in range throughout an automated series of runs.

Tip  We recommend a range of 1.0 when you are using an integrator or data system.
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Loading a File

When you are ready to load a file into the detector settings, select /Load / from the Files 
Menu. The screen will display the words "Load File 1:(filename)." Use the + and - keys to 
view the number and name of available files. When the desired file number appears, press 
[ENTER]. 

The confirmation message shown in Figure 45 will appear for one second. You are then 
returned to the Status Screen.

Figure 45. The message that's displayed when a file is loaded

Running Your Detector

Once you've set your detector parameters in the designated file and have loaded the file into 
the detector's operating parameters, you are ready to run your analysis. First, check the 
detector's status by viewing the Status Screen. If you are using a stop-line in your wavelength 
program, you will start and stop the run with each injection.

Status Screen

You can check the detector's status, wavelength setting(s), and absorbance reading(s) from the 
Status Screen. To access the Status Screen, press [STATUS]. The Status Screen for the 
UV2000 in dual-wavelength mode appears below (Figure 46). Note that, in the 
single-wavelength mode, the third line does not appear.

Figure 46. The UV2000's Status Screen for dual-wavelength operation

If the Status reads READY, the detector is stabilized and ready to run. If NRDY appears, the 
detector's lamps might need additional time to warm up, or a wavelength outside the selected 
lamp's range might have been chosen.

Tip  When a dual-wavelength program is loaded, you'll hear the motor start to operate in 
dual-wavelength mode even though you didn't press [RUN].
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Inject your Sample

When the detector is stabilized and you are ready to inject your sample, first manually zero the 
detector by pressing the [ZERO] key. If you are not using a stop-line in the wavelength 
program, the detector remains in the READY state throughout your chromatographic runs. If 
you are using a stop-line, you must start and stop the run with each injection, following the 
procedures below.

Starting a Run

If you are using a stop-line in your wavelength program, you need to start the run with each 
injection. There are two ways to start a run using the UV2000:

• Manually, by pressing [RUN] each time you make an injection.

• Automatically, by interfacing the detector with a remote run-signal from the injector (see 
Chapter 6, “Installation and Specifications,” for details). In this scenario, a signal that is 
equivalent to pressing [RUN] is automatically sent from the injector to the detector with 
each injection.

During the run, you can monitor the run time from the Status Screen.

Stopping a Run

There are two ways to stop a run:

• Manually, by pressing [STOP] before the programmed stop-time.

• Automatically, by allowing the run to finish at the programmed stop-time.

If you're conducting a dual-wavelength run, you can also stop the run by loading a 
single-wavelength file.

Regardless of how you stop a run, the detector returns to READY.

Changing Run Parameters

If you want to change the detector's parameters:

• You can use the Files Menu and follow the procedures outlined under “Setting 
Parameters” on page 26.

• Or you can use the Status Menu, which is the programming area below the Status Screen.

Each method has a distinct advantage. Programming in the Status Menu allows you to change 
the detector's current operating parameters, even while the detector is running. Programming 
in the Files Menu allows you to prepare an edit file containing the changes without altering 
the current detector settings. The file can then be loaded later.
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Status Menu

From the Status Screen, scroll down to the Status Menu (Figure 47). The Status Menu 
contains the loaded file identification (its number and name), Wavelength Program, Rise 
Time, Autozero Time, and Ranges.

Figure 47. The UV2000's Status Menu for dual-wavelength operation

The Status Menu shown in Figure 47 is typical for dual-wavelength operation. In the 
single-wavelength mode, only one wavelength field appears in the wavelength program.

The detector's parameters are set following the same instructions given under “Wavelength 
Program” on page 27 and “Options” on page 28 . However, you cannot modify either the file 
identification or the wavelength mode (dual or single) from the Status Menu.
 

Saving the File

When you change the UV2000's settings from the Status Menu, each change is effective as 
soon as you leave the field. You'll also see that the File identification on the first line of the 
Status Menu (Figure 47) now reads "File N:xxxx-changed" (where N:xxxx is the file number 
and name) and that the words "Save File" now appear below Range 2. 

To save the changed file, press [ENTER]. The confirmation message shown in Figure 48 will 
appear briefly.

Figure 48. The File Saved message

To keep the original file without saving the changes, don't press [ENTER]. Instead, reload the 
unaltered file using the Files Menu as follows:

1. Press [MENU].

2. Select /FILES/.

IMPORTANT  When you modify a file's parameters from the Status Menu, you do not 
change the contents of the same file number stored in the detector's memory. Only the 
copy of the active file is modified.
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3. Select /Load/.

4. The words "Load File" will appear on the screen. Enter the desired file number and press 
[ENTER].

A confirmation message (Figure 45) will appear for one second. You are then returned to the 
Status Screen, and all settings will contain their original values.

More About UV2000 Files
In Setting Parameters, you learned how to edit and load files from the Files Menu. The 
UV2000 also allows you to copy and delete files (and to protect files from being edited, 
copied to, or deleted) in a few steps. 

Copying Files

To copy a file 

1. Press [MENU].

2. Select /FILES/ to display the Files Menu (Figure 49).

Figure 49. The UV2000's Files Menu

3. Select /Copy/. The Copy Menu will appear on the screen (Figure 50).

Figure 50. The UV2000's Copy Menu

4. Enter the identification number for the file you want to copy in the Copy File field.

5. Enter the number of the file to which you want to copy in the To File field.

6. Press [ENTER]. The confirmation message shown in Figure 51 appears briefly, and you 
are returned to the Files Menu.

Figure 51. The message that's displayed when a file is copied

If you attempt to copy to a protected file (see Protecting Files), you will get the message shown 
in Figure 52. If a file is not protected, make sure it's empty or unwanted before you copy to it, 
as it will be overwritten.
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Figure 52. The message that is displayed when you attempt to copy to a protected file

You cannot use Copy for the Scan or Develop files. You will learn more about these files in 
Chapter 4, “Advanced Operations.” 

Deleting Files

To delete a file

1. Press [MENU].

2. Select /FILES/ to display the Files Menu (Figure 40).

3. Select /Delete/. The Delete File field will appear on the screen.

4. Enter the identification number of the file you want to delete. When you press [ENTER], 
the confirmation message shown in Figure 53 appears briefly and the display returns to 
the Files Menu. (The parameters in the file you have just deleted return to their default 
values.)

Figure 53. The message that's displayed when a file is deleted

If you attempt to delete a protected file (see the next section, Protecting Files), you will get the 
message shown in Figure 54.

Figure 54. The message that's displayed when you try to delete a protected file

Protecting Files

The UV2000 allows you to protect files from being edited, copied to, or deleted. 

To access the file protection operation

1. Press [MENU].

2. Select /OPTIONS/. The Options Menu appears in Figure 55.
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Figure 55. The UV2000's Options Menu

3. Select /More/. The More Menu appears in Figure 56.

Figure 56. The UV2000's More Menu

4. Scroll down to the Table containing the fields File Name and Protect. To protect a file, 
select On in the Protect field corresponding to the appropriate file number. To remove the 
file protection, select Off.
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UV1000 Analog Signals
The UV1000 detector has two analog outputs.

Analog Outputs

There are two analog outputs for the UV1000: Analog Output 1and Analog Output 2. On 
the detector's rear panel, they appear as "Unranged output" and "Ranged Output." Analog 
Output 1 is set at 1 V/AU and is intended for an integrator interface. Analog Output 2 is 
range-selectable and is used for recorders and other devices. Rear-panel connections for both 
outputs are discussed on page 85.

Analog Offsets

Analog offsets can be used when there is a high background absorbance reading, or when 
there is considerable baseline drift from your chromatographic system and you are unable to 
keep your integrator's (recorder's) signal on-scale.

Because integrators have very limited capacity for handling negative signals, you might want 
to set a small positive offset (1%) when using an integrator.

Use negative offsets with recorders, where you might want to set the pen at either side of the 
strip chart.

Offset options are selectable from the Analog Outputs Menu. 

To access these options

1. Press MENU.

2. Select /OPTIONS/.

3. Select /Analog Outputs/.

The Analog Outputs Menu is shown in Figure 57.

Figure 57. The UV1000's Analog Outputs Menu

Tip  Although the default for the Analog 1 offset is set at zero, we recommend a 1 mV 
setting for use with your data system or integrator.
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UV2000 Analog Signals
The UV2000 produces two analog signals.

Analog Outputs

There are two analog outputs on the UV2000, Analog Output 1 and Analog Output 2. On 
the detector's rear panel, they appear as ANLG 1 Output and ANLG 2 Output. Rear-panel 
connections for both outputs are discussed on page 90.

Analog Output 1

By default, Analog Output 1 is either the absorbance reading for single-wavelength operation, 
or the absorbance reading of wavelength one (1) for dual-wavelength operation.

Analog Output 2

Analog Output 2 is selectable (AU, AU1-K*AU2, and AU1/AU2), and so can be used to 
monitor several different outputs. 

To access these options

1. Press [MENU].

2. Select /OPTIONS/.

3. Select /Analog Outputs/. The Analog Outputs Menu shown in Figure 58 appears.

Figure 58. The UV2000's Analog Outputs Menu

4. Scroll down to Analog 2. The selections are:

• AU, which is either the same absorbance reading you got from Analog Output 1 in 
single-wavelength operation, or the absorbance reading of wavelength two (2) for 
dual-wavelength operation.

• AU1-K*AU2, which is the readout of the suppressed signal using the K-Factor 
technique. See “K-Factor (UV2000)” on page 63 for more details.

• AU1/AU2, which is the ratio of the dual-wavelength absorbance values. This ratio is 
sometimes used to check peak purity. See “Absorbance Ratios (UV2000)” on page 68 
for more details.
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Analog Offsets

Both analog outputs 1 and 2 can be offset on the UV2000. Analog offsets can be used in cases 
where there is a high background absorbance reading, or when there is considerable baseline 
drift from your chromatographic system and you are unable to keep your integrator's 
(recorder's) signal on-scale.

Because integrators have very limited capacity for handling negative signals, you might want 
to set a small positive offset (1%) when using an integrator. 

Negative offsets are available for use with recorders, where you might want to set the pen at 
either side of the strip chart.

The offset options are selectable from the Analog Outputs Menu shown in Figure 58.

Tip  Although the offset for each output is set at 0% of full-scale readout by default, we 
recommend a 1% setting for use with your data system or integrator.
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4

Advanced Operations

In this chapter, you will learn to use the more advanced capabilities of your detector. You 
should be familiar with the instructions presented in Chapter 3, “Basic Operations,” before 
you begin.

Wavelength Programming
Your detector can change wavelength as a function of time, a feature we call Wavelength 
Programming. This feature gives you maximum detection sensitivity for each component of a 
mixture without making multiple injections of the sample.
 

Building the Program

In wavelength programming, you enter time lines into a "Wavelength Program." Each time 
line specifies the time at which you want a wavelength change to occur.

Contents

• Wavelength Programming

• Programmed Autozero

• Automatic Lamp Operations

• Other Features

• Scanning (UV2000)

• Automatic Scanning (UV2000)

• The Develop File (UV2000)

• Sample Queue (UV2000)

• K-Factor (UV2000)

• Absorbance Ratios (UV2000)

Tip  A wavelength program can be built in either the Status Menu or the File(s) Menu. 
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The following instructions are for single-wavelength operation, but you can build a 
dual-wavelength program using the same procedure.

Initial Conditions

Access the Wavelength Program (Figure 59) through either the Status Menu or the Files 
Menu.

Figure 59. The wavelength program for single-wavelength operation

The initial time entry is 0.00. Move the cursor to the corresponding Wavelength field, and 
enter the initial wavelength for your analysis.

Adding Lines

To add a second time line, scroll down to the first blank line and press +. The second line will 
automatically have a time setting of 1.00 and the same wavelength setting as the first. Change 
the Time and corresponding Wavelength fields to the desired values. Subsequent lines are 
added in the same fashion.

A wavelength program can contain as many as ten lines for a single run. On the UV1000, all 
of the lines' wavelengths must be in the same range (either UV or visible). On the UV2000, 
however, you can cross between the UV and visible ranges (in single-wavelength mode only). 

If you enter time lines out of sequence, the detector will automatically sort the lines and place 
them all in chronological order.

The Stop-line

The last line of the program (the stop-line) lists the time at which the detector will 
automatically end the run and return to initial conditions. Since wavelength is not important 
in the stop-line, it can be set to any value.
 

Deleting a Line

To delete an entire time line, place the cursor in the Time field and press - repeatedly until the 
value goes blank. When you leave the line, it will be deleted.

An Example

Figure 60 shows a completed wavelength program for single-wavelength operation.

IMPORTANT  Remember, the last line of the program is always the detector's signal to end 
a run; it is not a programmed wavelength change.
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Figure 60. An example of a completed wavelength program

In our example, the initial detection wavelength is 254 nm. At 5.00 minutes into the run, the 
wavelength changes to 280 nm. At 7.00 minutes, it changes to 265 nm. The run ends at 
10.00 minutes, and the detector returns to its initial wavelength of 254 nm and to its READY 
state.

Running the Program

After you set the rest of your parameters, the detector is ready to run. It is good practice to 
zero the detector at the beginning of every run and at each wavelength change. See the next 
section, Programmed Autozero, for details.

Once you start the run, you can edit any timed event (wavelength change, autozero, or 
stop-time) that has not yet taken place. These edits can only be made from the Status Menu 
however. Each edit is entered immediately into the detector's operating wavelength program.

For example, for the program displayed in Figure 60, the stop-time is 10.0 minutes. If, at 
7.00 minutes into the run, you determine that the run should be 9.00 minutes long, you can 
edit the last line of the program such that the current run will stop at 9.00 minutes.
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Programmed Autozero
The detector can be programmed to perform an automatic zero with each wavelength change 
during a run using the Zero on λ Change field. 

To access this feature

1. Press [MENU] and select /OPTIONS/ to access the Options Menu (Figure 61).

Figure 61. The Options Menu

2. Select /More/ to display the More Menu.

3. Place the cursor on the Zero on λ Change field. This field appears on the first line of the 
More Menu.

4. Select Yes, to automatically zero the detector response with each wavelength change 
during a run, or No, to turn this feature off.

You can also use this automatic zero feature to add autozeros into your wavelength program 
without changing the detector's wavelength settings. To do this, add additional time lines. 
Adding autozeros in this way is convenient in cases such as solvent programming, where the 
detector's baseline might drift due to changes in solvent background.

An example program is shown in Figure 62.

Figure 62. An example of a wavelength program with automatic autozeros

With Zero on λ Change set to Yes, the detector will autozero at 2.00, 5.00, and 7.00 minutes 
into the run, even though the wavelength will only change once (at 5.00 minutes into the 
run).
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Automatic Lamp Operations

The Lamps Menu

The Lamps Menu (Figure 63) allows you to select lamps, track lamp life, and turn the lamps 
on and off automatically. Field descriptions for this menu follow.

To access the Lamps Menu

1. Press [MENU] and select /OPTIONS/.

2. Select /Lamps/.

Figure 63. The UV2000's Lamps Menu 

• Lamp

The Lamp field allows you to select from the following: 

− D2 (190-365), for deuterium
W (366-800), for tungsten
[the UV1000 reads D2 (190-380)]

− D2+W (190-800), for dual-lamp operation

− or Off, to shut the lamp(s) off 

Actually though, the wavelength setting in the loaded file automatically selects the 
appropriate lamp for you. In fact, the wavelength setting you choose in your file has 
priority over any selection you make here in the Lamp field!

For example, if the loaded file designates a wavelength in the UV range, but you manually 
selected W (366-800) in the Lamp field, the detector's display will read NRDY (not 
ready) for the deuterium lamp.

• Lamp Hours (W and D2 fields)

These fields automatically track the number of hours each lamp has been in operation. 
For the value to be accurate, set the appropriate Lamp Hours field to zero each time you 
install a new lamp.
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• Startup and Shutdown

When you set the Startup and Shutdown fields to "Manual," the lamp designated in the 
Lamp field turns on and off when the detector power is switched on and off, respectively.

• Startup and Shutdown Times

When you set the Startup and Shutdown fields to "Time" (see above), the designated 
lamp will automatically turn on and off at the local time set in the Startup Time and 
Shutdown Time fields, respectively.

• Time from READY

If you prefer, you can program the detector to shut the lamp off after a series of 
automated runs by using the Time from READY feature. Time from READY is a preset 
time interval that automatically begins each time the detector returns to its READY state. 
If the Time from READY interval elapses without a run signal being received from either 
the keypad or the detector's Run (Input) terminal, the detector's lamp turns itself off.

To use the Time from READY feature

1. Select Time from READY in the Shutdown field.

2. In the Time from READY field, enter the length of time during which a run signal must 
be received by the detector before the lamp turns off.

For example, let's say your chromatographic system is set up for an automated run and the 
autosampler signals the detector to run after each injection. With the detector settings shown 
in Figure 64, the lamp will turn off ten hours after the last run is completed.

Figure 64.  An example of the Time from Ready feature

You can also program the UV2000's lamps to turn off at the end of a queue by selecting End 
of Queue in the Shutdown field. For more information on the Queue feature, see page 58.

Tip  If you switch lamps before they are burned out (with the intention of using them 
again at a later date), keep a record of how many hours they have been in operation.

IMPORTANT  For the detector to perform automatic lamp startup and shutdown 
correctly, the detector's 24-hour clock must be set to your local time. Set the clock in 
the Current Time field. Since the clock resets to zero each time the detector is turned 
off, it will have to be reset prior to performing automatic lamp startup and shutdown 
unless the detector has been left on continuously.
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Other Features
Additional features offered by the UV1000 and UV2000 detectors include the abilities to lock 
the Status Screen, to short the detector outputs, to place an event mark on the chromatogram, 
and to send a ready signal to external devices. You can also control the display's contrast and 
cursor speed, and do a quick shutdown of the detector's lamps and motors.

Status Lock

You can lock the detector's display using the Status Lock field. This feature lets you prevent 
accidental changes to a file that is currently being run. With the lock on in the UV1000, only 
the Status Screen appears. In the UV2000, you can scroll down from the Status Screen as far 
as the Status Menu's File Name field. You will still be able to access the Main Menu and the 
rest of the menu structure using the MENU key however.

To access Status Lock

1. Press [MENU].

2. Select /OPTIONS/.

3. Select /More/.

4. Scroll down to Status Lock. Select On or Off to turn the lock on or off, respectively.

5. Press [STATUS].

Short Outputs

When zeroing a readout device such as an integrator or recorder, it's convenient to be able to 
short the detector outputs. You can do this using the Short Outputs feature.

To access Short Outputs 

1. Press [MENU].

2. Select /COMMANDS/. The Commands Menu (Figure 65 appears.

Figure 65. The Commands Menu
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When you select /Short Outputs/, the detector's analog outputs are shorted together (zero 
volts) and the field name changes to "Unshort Outputs." To remove the short and return the 
outputs to their normal operating state, select /Unshort Outputs/, and the field changes back, 
now reading "Short Outputs." (When you leave this screen, the field returns automatically to 
Short Outputs.)

Event Mark

Using the event mark feature, you can place an event mark on your chromatogram to note 
various occurrences, such as the turning of a sampling valve. The event mark is a spike (15% 
of full-scale for one second) in both detector output signals.

To access Event Mark 

1. Press [MENU].

2. Select /COMMANDS/. The Commands Menu (Figure 65) appears.

3. Place the cursor on Event Mark. Press [ENTER] each time you want to place an event 
mark on your chromatogram.

Ready Output

Using the READY (Output) terminal on the detector's back panel, the detector can send a 
signal to other devices each time it goes to its READY state. This feature is frequently used 
with autosamplers to signal that the detector is ready for the next injection.

To access the READY Output field 

1. Press [MENU].

2. Select /OPTIONS/.

3. Select /More/.

4. Scroll down to the READY Output field. Select Active Hi or Active Lo, depending on 
which signal you want to send.

Display Contrast

You can vary the display's contrast to make it easier to read.

IMPORTANT  You might not want to use event marks if your data will be analyzed by an 
integrator. Integrators can misinterpret event marks as peaks.

Tip  All SpectraSYSTEM instruments are set to receive high signals, so select Active Hi if 
you are hooking up to this type of chromatograph. For any other type of instrument, refer 
to the appropriate reference manual.
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To change the display's contrast, first press [STATUS ]to access the Status Screen. Then 
simultaneously press the  key and the + key to increase the contrast, or the  key and 
the - key to reduce the contrast.

Cursor Speed

You can control the display's cursor speed to make it easier to use.

To access Cursor Speed 

1. Press [MENU].

2. Select /OPTIONS/.

3. Select /More/.

4. Scroll down to Cursor Speed and select Fast, Medium, or Slow.

Shutdown Detector

This feature offers a quick shutdown, and subsequent startup, of the detector's lamps and 
motors. The electronics stay on to maintain the detector's memory.

To shut down the detector 

1. Press [MENU].

2. Select /COMMANDS/.

3. Scroll down to the Shutdown Detector field.

4. Press [ENTER]. The confirmation message shown in Figure 66 appears on the display.

Figure 66. Shutdown confirmation message

To start the detector up again, press any key on the keypad. The detector will come up under 
the same conditions present when the Shutdown Detector command was activated.
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Scanning (UV2000)
The UV2000 can perform a spectral scan on eluting peaks without stopping the eluant flow. 
This unique feature greatly simplifies the determination of wavelength maxima for individual 
compounds in your sample during method development work.

How It Works

When a scan is initiated, the monochromator moves from the run-wavelength to the scan's 
start-wavelength. The detector scans by stepping through a defined spectral range at specified 
wavelength increments. Individual absorbance values are read at each increment until the 
monochromator has reached the last wavelength.

The UV2000 can collect and store as many as ten spectra from a single chromatographic run 
in its memory. The actual number of spectra is determined by the number of data points in 
each scan. Since the number of data points varies with the wavelength interval and the 
scanning range, first calculate the number of data points using Equation 1, then use either 
Equation 2 or Equation 3 to determine the number of spectra you will be able to collect.

Equation 1. Use this equation to calculate the number of data points for any scan between 
λ1 (the lower wavelength), and λ2 (the higher wavelength):

Equation 2. Use this equation to calculate the number of spectra you can collect when using 
wavelength intervals of 2 nm or greater. Round the resulting number down to the nearest 
integer.

Equation 3. Use this equation to calculate the number of spectra you can collect when using 
wavelength intervals of 1 nm. Round the resulting number down to the nearest integer.

For example, if you want to scan from 190 to 564 nm in 2-nm steps, there would be 188 data 
points and the UV2000 would be able to store up to 3 spectra:

Each scan is corrected for baseline absorbance before being played back either as individual 
data points, or as a smoothed, continuous spectrum.

# of data points λ2 λ1–
λintervals
-----------------------=

# of spectra
5000 # of data points * 12( )–

# of data points * 4( ) 14+
---------------------------------------------------------------=

# of spectra
5000 # of data points * 4( )–

# of data points * 4( ) 14+
-------------------------------------------------------------=

# of spectra
5000 188 * 12( )–

188 * 4( ) 14+
---------------------------------------- 2744

766
----------- 3.58=== 3=
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Selecting the Scan File

To select spectral scanning

1. Press [MENU]. Select /FILES/.

2. Select /Edit/.

3. Use the + key to increment the Edit File field until an "S" is displayed (Figure 67). The 
File Name field is automatically named SCAN. (You cannot edit the Scan File's name.)

Figure 67. The Scan File's Edit Menu

4. Select /Setup/ to set up your spectral scanning parameters.

Setting Up the Scan File

The Scan File's Setup Menu is shown in Figure 68.

Figure 68. The Scan File's Setup Menu

To set the parameters for scanning

1. In the Start λ field, enter the wavelength at which each scan should start.

2. In the End λ field, enter the wavelength at which each scan should end.

3. In λ Interval, enter the wavelength interval to be used. To perform a scan, the UV2000 
takes individual absorbance readings at wavelengths incremented by the interval you 
specify.

4. In Run λ, enter the wavelength at which the chromatographic run will be monitored.

Tip  Five nanometers is an excellent wavelength interval for most applications. At this 
interval, you get very rapid scans and you can still display the Max to 1 nm accuracy.
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5. In Scan Zero Time, enter the runtime at which you want the detector to perform an 
automatic baseline scan. If you use an automatic baseline scan, make sure no peaks are 
eluting during the designated scan time.

6. Fill in entries for Rise Time, Range 1, and Range 2 as you would for any chromatographic 
run.

When you are finished setting up the Scan File, you are ready to load it and run.

Running the Scan File

When the Scan File is loaded, you will notice the fields Zero and Scan in the Status Screen 
(Figure 69).

Figure 69. The Status Screen with the Scan File loaded

• Zero

Zero is used to perform baseline scans of the solvent's background absorbance. With the 
detector's baseline stabilized and the cursor on the Zero field, press [ENTER]. The 
UV2000 performs and stores a baseline scan using the parameters you set in the Scan File. 
While the detector is performing a baseline scan, the Status field displays SCAN 0.

Baseline scans can be taken at any time during the run, as long as no peak is eluting at 
that time. Subsequent sample scans are corrected using the last baseline scan taken. This is 
especially advantageous for gradient elution, where the background absorbance of the 
eluant might be constantly changing.

For example, let's say you perform a baseline scan before you initiate a run, and then 
again at 5.00 minutes into the run. You also perform sample scans of your eluting peaks 
at 2.4 and 5.6 minutes into the run. The sample scan taken at 2.4 minutes will be 
corrected using the baseline scan taken before the run began. The sample scan taken at 
5.6 minutes will be corrected using the baseline scan taken at 5.0 minutes.

• Scan

Once you begin the run, the cursor will move from Zero to Scan in the Status Screen. 
Each time you want to perform a sample scan, press [ENTER]. 

IMPORTANT  There is a one-second delay from the time the detector takes its 
absorbance readings to the time you see the same reading on the analog readout. Keep 
this in mind when choosing your scan times.
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Each time you perform a sample scan, the detector's monochromator moves from the 
run wavelength to the start wavelength. The detector performs each scan (from the start 
wavelength to the end wavelength) by taking individual absorbance readings at 
wavelengths incremented by the interval you set in the Scan File. When the scan is 
finished, the monochromator returns to the run wavelength.

For example, using the default Scan File Setup Menu shown in Figure 68, the detector 
would monitor the run at 250 nm. Each scan would include absorbance readings for 
wavelength settings of 220, 225, 230, 235, and so on, up to 350 nm.

While the detector is scanning, the Status field displays SCAN.

Scan Summary Data Screen

When the Scan File is loaded, the normal Status Menu no longer appears below the Status 
Screen. Instead, several new lines that we call the "Scan Summary Data Screen" appear. The 
Scan Summary Data Screen is useful in setting up the parameters to replay your stored 
spectra. 

An example of the Scan Summary Data screen as it appears after two sample scans is shown in 
Figure 70.

Figure 70. An example of the Scan Summary Data Screen

The Scan Summary Data Screen has four fields: 

• Time, which is the run time at which the scan was initiated

• λMax, which is the scan wavelength where the maximum absorbance occurred

• λMaxAU, which is the maximum absorbance

IMPORTANT  If you chose starting and ending wavelengths that were not an exact 
multiple of your wavelength interval, the ending spike (event mark) on your 
chromatogram would be placed at the last multiple of the wavelength interval that 
falls within the scanning range. For example, with a starting wavelength of 200 nm, 
an ending wavelength of 365 nm, and a wavelength interval of ten, the end spike on 
your chromatogram would be at 360 nm, the last full wavelength multiple within the 
range.

IMPORTANT  During scanning, the output signal will hold at the last absorbance 
value taken before the scan was initiated until the scan is finished. For this reason, 
quantitative analysis should never be performed when scanning. 
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• λMin, which is the scan wavelength where the minimum absorbance occurred

If no maximum was found, the λMax and λMaxAU fields read 0 (zero). The summary 
information is updated as each sample scan is completed.
 

In our example (Figure 70), scans were taken at 10.50 and 11.66 minutes into the run. The 
scan taken at 10.50 minutes has a maximum absorbance of 1.6668 AU at 280 nm. The 
minimum absorbance occurred at 230 nm. To replay your 10.50-minute scan, you would use 
a range of 2.0 AUFS to keep the absorbance values on-scale.

Stopping the Scan File

There is no programmed stop in the Scan mode. The run will continue until it reaches 
99.99 minutes, or until you press [STOP].

Automatic Scanning (UV2000)
If you've set the Auto Scan field in the Setup Menu to On, your detector will perform an 
automatic scan whenever there are at least three consecutive data points with positive slopes 
followed by three consecutive data points with negative slopes. The absorbance values for all 
these data points must exceed 5 percent of the value set in the Range 2 field. In our example 
chromatogram (Figure 71), a scan would occur automatically for Peak A, since it has at least 
three data points with positive slopes followed by at least three data points with negative 
slopes, all of which exceed 5% of the value set in Range 2. Conversely, no scan would occur 
for peak B, since none of its absorbance values exceeds the 5% threshold, even though it 
might satisfy the consecutive-slope criteria.

Tip  The UV2000 uses a second derivative to find the "local" λMax.
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Figure 71. An example of how automatic scanning works

An automatic baseline scan will occur at the time specified in the Spectra Menu's 
Scan Zero Time field.
 

Replaying Your Spectra

When you have completed your run, you can retrieve your stored sample spectra using the 
Replay Menu (Figure 72).

To access the Replay Menu

1. Press [MENU]. Select /FILES/.

2. Select /Edit/ to display the Scan File's Edit Menu (Figure 67).

3. Select /Replay/.

Figure 72. The Replay Menu

IMPORTANT  Make sure that no peaks are eluting at the specified scan-zero time or your 
baseline scan will be zeroed erroneously for the eluting peak's value at the moment when 
the scan zero occurs. This will produce a baseline scan that is heightened artificially.

Peak A

Peak B

5% of Range 2

Time
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Setting Replay Parameters

To set the parameters for replay

1. Set Range 1 and Range 2 for Analog Output 1 and Analog Output 2. If you are using 
only one output, disregard the appropriate range.

2. Enter the Replay Rate (nm/sec). This is the rate at which the detector will read out the 
spectral data to your chart. You will use this value and an appropriate chart speed to 
calculate wavelength increments on your printed sample spectrum.

For example, if your sample scan were taken between 190 and 340 nm (a span of 
150 nm), a replay rate of 5 nm/sec would print the spectrum in 30 seconds. A chart speed 
of 30 cm/min would give you a scan of 15 centimeters in increments of 10 nm/cm.

3. Select the spectrum you want to replay by selecting its start time in the Spectra Time 
field. Each spectrum taken during the run is individually identified by the run time at 
which it was initiated.

When you finish setting your replay parameters, you are ready to send the spectral data to 
your chart using the Replay Spectra command.

Running Replay

To initiate the Replay Spectra command in the Replay Menu, press [ENTER]. While the 
replay is occurring, the screen shown in Figure 73 appears on the display.

Figure 73. The display as it appears while spectra are being replayed

The screen's Replay field displays the start time of the spectrum being replayed. The λ and 
AU fields display the individual data points being plotted.

The UV2000 uses advanced curve-fitting algorithms to present a smooth, continuous plotted 
spectrum. The spectrum is replayed in 1 nm steps regardless of the wavelength interval 
selected. To change the appearance of replayed spectra from 1 nm stepped curves to smooth 
curves (or vice versa), vary the recording device's replay rate and response time.

If no spectra are stored in memory when you activate the Replay Spectra command, the 
message shown in Figure 74 will appear on the display. When the replay is finished, the 
display returns to the Replay Menu.

Figure 74. The message that appears when no spectra are stored in memory
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Stopping Replay

You can stop a replay at any time by pressing [STOP].

Spectral Data Storage

Spectral data are stored in the UV2000's memory until a new file or queue is loaded or the 
detector is turned off.

Viewing Data

You can display the individual data points of your stored spectra by selecting the Display AU, 
λ field in the Replay Menu (Figure 72). A screen similar to that shown in Figure 75 will 
appear on the display.

Figure 75. The Display AU, λ screen

The Display AU, λ screen shows the time at which the scan was initiated, along with each 
wavelength and absorbance reading collected. You can scroll through the data using the 
+ and - keys. To return to the Replay Menu, press .

Note  Only actual data points (separated by the proper wavelength interval) can be 
displayed.
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The Develop File (UV2000)
The Develop File is unique to the UV2000. It allows you to make sequential sample 
injections at different wavelengths automatically. This automation makes method 
development much easier because you can use an automated run to determine the optimum 
wavelength of detection for each component in your sample. You can also use the Develop 
File to troubleshoot chromatographic problems, or to confirm method transfer from 
laboratory to laboratory.

Selecting the Develop File

To select the Develop File 

1. Press [MENU]. Select /FILES/.

2. Select /Edit/.

3. Use the + key to increment the Edit File field until a "D" is displayed. The File Name 
field will read DEVELOP. (You cannot edit the Develop File's name.)

Editing the Develop File

To edit Develop File parameters 

1. Once you've selected the Develop File as described above, press either the [ENTER] or 
the key to access the Develop File's Edit Menu (Figure 76).

Figure 76. The Develop File's Edit Menu

2. In the Start λ field, enter the wavelength at which the first chromatogram is to be 
monitored.

3. In the End λ field, enter the wavelength at which the last chromatogram is to be 
monitored.
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4. In λ Interval, enter the wavelength increment that the detector's monochromator should 
use for each wavelength change.

5. In Run Time, enter how long each run should last.

6. In Runs per λ, enter the number of injections to be made at each wavelength setting.

7. Enter Rise Time, Autozero Time, Range 1, and Range 2, as you would for a typical run. 
Note that Range 1 and Range 2 are the corresponding ranges for Analog Outputs 1 
and 2, respectively.

As an example, we will use the Develop File shown in Figure 76. The UV2000 would make its 
first two ten-minute runs at 220 nm. The monochromator would then change to 225 nm, 
and the detector would make two runs at this wavelength. This pattern would continue in 
five-nanometer increments until the detector has made two runs at the last wavelength, 
350 nm.

After setting up your Develop File, you are ready to load it and run.

Running the Develop File

When the Develop File is loaded, you will notice an additional field in the Status Screen, 
#Runs (Figure 77).

Figure 77. The Status Screen with the Develop File loaded

• #Runs

The #Runs field in the Status Screen shows the current run number, followed by a 
forward slash and the total number of injections for the wavelength specified in the 
λ field. For example, if the file is set up to make three injections per wavelength, and the 
detector is in the second run for the 250 nm setting, the #Runs field would appear as 2/3. 
The field is updated with each injection.

• Status Menu

The Status Menu looks the same for a Develop File as it does for a typical 
chromatographic file (Figure 78).
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Figure 78. The Status Menu with the Develop File 

Repeating the Develop File

After the last wavelength is run, the detector is reset automatically to the starting wavelength 
in the Develop File. The file can be run as many additional times as you want, as long as the 
detector continues to receive run signals.

Sample Queue (UV2000)
Sometimes it's convenient to group samples together under different detector conditions in an 
automated run. For these occasions, the UV2000 offers a queuing feature. Using a queue, you 
can program the detector to load and run a specified file for your first group of samples, and 
then automatically load a second file to run your next group of samples. The queue feature 
allows you to run as many as ten groups in a single queue.

IMPORTANT  You can change any of the parameters in the Status Menu while the 
detector is running, but the changes will be effective only until the next wavelength is 
loaded.
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Queue Menu

To access the Queue Menu 

1. Press [MENU].

2. Select /QUEUE/.

When no queue is loaded, the Queue Menu appears as shown in Figure 79. On page 60, 
we'll see how the menu appears when a queue is loaded.

Figure 79. The Queue Menu with no queue loaded

Setting Up a Queue

To set up a queue, select /Edit / from the Queue Menu. For an empty queue, the display 
appears as shown in Figure 80.

Figure 80. An empty queue

Entering a Line

A "1" is automatically placed in the Order field of the first file to be run. You can't change 
that, so the cursor appears under the first editable field, File:Name. Scroll through the 
available files and press [ENTER] when your choice appears.
 

Enter the number of injections to be made in the #RUNS field and press [ENTER]. You can 
have as many as 999 injections per file.

Adding More Lines

After completing the first line, a second line appears automatically. The Order field reads 2, 
and the rest of the line is blank. Select the proper file and the number of injections to be made 
for that file. You can have as many as ten groups in the queue.

Deleting a Line

To delete a line, use the - key in the File:Name field until it goes blank. When you leave the 
line, it is deleted and the queue is resorted automatically.

IMPORTANT   You can only select numbered files. The Scan and Develop files are not 
available in the Queue mode.
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An Example

An example of a queue appears in Figure 81.

Figure 81. An example of a queue

In our example, we have programmed the detector to run File 2 for the first five injections, 
File 3 for the next 25 injections, and File 1 for the last ten injections.

Loading a Queue

To load a queue, select /Load/ in the Queue Menu. When the words "Load Queue" appear, 
press [ENTER]. The confirmation message in Figure 82 appears for one second.

Figure 82. The confirmation message when a queue is loaded

When a queue is loaded, the letter "Q" appears at the extreme left of the Status Screen 
(Figure 83).

Figure 83. The Status Screen when a queue is loaded

If you attempt to load a queue when no queue exists, the message shown in Figure 84 will 
appear on the display.

Figure 84. The message that is displayed when no queue is available

Running a Queue

When the detector receives its first start signal, it loads and runs the file designated in 
Order 1. It will continue to run this file each time it receives a start signal until the file has run 
the number of times specified in the #Runs field. The detector will then load and run the file 
designated in Order 2 and run it the number of times specified in that line, and so on, until 
the entire queue has run.
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Viewing its Progress

To view a queue's progress while it is running 

1. Press [MENU].

2. Select /QUEUE/. Note that when a queue is loaded, the Queue Menu (Figure 85) looks 
different. The Load field has been replaced by "Pause," which we will discuss on page 62.

Figure 85. The Queue Menu with a queue loaded

3. Select /Edit/ to display the queue. (Refer to Figure 81 for an example queue.)

While the queue is running, the #Runs field automatically decreases by one with each 
injection. When a particular file's last injection is made, the queue is automatically resorted. 
In other words, the information for Order 2 is now moved up to Order 1, the information for 
Order 3 is moved up to Order 2, and so forth. This process continues until the queue 
becomes empty, is paused, or is deleted.

Loading other Files

When a queue is loaded or running, you can not load any other file from the Files Menu 
without first pausing or deleting the queue. If you forget to pause or delete the queue and 
attempt to load a different file, you will get the message shown in Figure 86. You are then 
returned to the Files Menu.

Figure 86. The message that appears when you attempt to load a file when a queue is already 
loaded or running

Editing a Queue

To edit an existing queue, follow the procedures outlined in “Setting Up a Queue” on 
page 59. You are allowed to edit the Queue while it is running, but if you want to edit 
anything in Order 1, you'll have to pause the queue first.
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Pausing a Queue

To pause a queue 

1. Select /Pause/ from the Queue Menu.

2. When the words "Pause Queue" appear, press [ENTER]. If a file is running, the run 
continues until it is completed, at which point the detector returns to its READY state. 
The letter Q no longer appears in the Status Menu.

When you want to continue, you must reload the queue. When the detector receives a start 
signal, the queue will resume operation at the point where it left off.

Deleting / Stopping a Queue

To delete an existing queue or to stop a running queue

1. Display the Queue Menu.

2. Select /Delete/.

3. When the words "Delete Queue" appear, press [ENTER]. If a file is running, the run 
continues until it is completed. The confirmation message shown in Figure 87 appears for 
one second and you are returned to the Queue Menu.

Figure 87. The queue-deleted message

You can delete or stop a queue at any time, but remember that the queue will be subsequently 
erased from the detector's memory. It is good practice to delete an existing queue prior to 
designing a new one.
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K-Factor (UV2000)
The K-factor calculates a factored response that can be used to eliminate, add, or subtract 
absorbances. This technique is useful for suppressing peaks when there are two co-eluting, or 
poorly resolved, peaks in your chromatogram. It is also useful in applications where you want 
to add or subtract absorbances at two different wavelengths in real-time. 

For example, if you want to quantitate a peak without interference from another peak, you 
would use the K-factor to calculate a response of zero.

More specifically, let's say you want to analyze for Compound A in the presence of 
Compound B. If both absorb at the monitoring wavelength, 1, but only Compound B 
absorbs at a second wavelength, 2, you can calculate a K-factor for Compound B using its 
absorbances at 1 and 2. You can then use the K-factor to calculate the absorbance due only to 
Compound A at the monitoring wavelength (1), by subtracting Compound B's contribution 
from the total absorbance. The UV2000 uses the algorithm:

where TAbs(λ1) is the sum of the absorbances of A and B at the monitoring wavelength, 
K is the K-factor, and TAbs(λ2) is the total absorbance obtained at λ2.

Figure 88 shows a chromatogram of a mixture of toluene and butyl paraben where the two 
compound peaks overlap. Toluene (Peak A) is the compound of interest. Butyl paraben 
(Peak B) is the peak we want to suppress. We will use this example throughout the following 
steps for determining and using the K-factor.

Absorbance due to A at λ1 TAbs λ1( ) K x TAbs λ2( )–=
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Figure 88. A chromatogram of two unresolved peaks toluene (A) and butyl paraben (B)

Choosing a Pair of Wavelengths

The first step in determining the K-factor is to choose a pair of wavelengths for your analysis.

1. Take an absorbance spectrum of each compound. You can do this by injecting samples of 
compound A and compound B alone, separately, under the same chromatographic 
conditions as your analysis, and using the UV2000's scanning feature. See “Scanning 
(UV2000)” on page 48.

For the compounds in our example, we get the spectra shown in Figure 89.

1.35 1.51

Time (in minutes)

B

A
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Figure 89. Spectra of individual compounds

2. Label the wavelength maximum for your peak of interest as 1.

3. From the spectra, pick a wavelength for which compound B absorbs and compound A 
does not. This wavelength is labeled 2. For our example, we have chosen 254 nm as 1 and 
280 nm as 2.

Calculating the K-factor

Use the UV2000's Display AU, λ screen (Figure 75) to obtain the individual absorbance value 
data from your scan of compound B. 

Calculate the K-factor using the following equation:

where AU1 and AU2 are the absorbance values for compound B at λ1 and λ2, 
respectively.

Butyl Paraben

Toluene

Wavelength (nm)

200 380

200 380

K AU1/AU2=
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For our example, the absorbance values are 0.0144 and 0.0032 (for 254 and 280 nm 
respectively), so our K-factor is 4.5, calculated as follows:

Using the K-Factor

To use the K-factor

1. Press [MENU].

2. Select /OPTIONS/.

3. Select /Analog Outputs/. 

The menu shown in Figure 90 will appear.

Figure 90. UV2000's Analog Outputs Menu

4. Scroll down to Analog 2 and select AU1-K*AU2.

5. Scroll down to K-factor and enter your calculated value (4.5, for our example).

6. Inject your sample. 

7. Use Analog Output 2 on the detector's rear panel to monitor the chromatograms for your 
peak of interest.

K 0.0144 / 0.0032 4.5==

Tip  Make sure your file was set to dual-wavelength mode as described in Chapter 3, 
“Basic Operations.” Also remember that in this example, AU1  (1) is 254 nm and 
AU2 (2) is 280 nm.
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Figure 91. Chromatogram of toluene with butyl paraben suppressed

Our example chromatogram would now appear as shown in Figure 91, with a slightly lowered 
response for toluene and no absorbance contribution from butyl paraben. Using the K-factor 
in this way, we can quantitate toluene in the presence of butyl paraben without altering the 
chromatography.

1.51

Time (in minutes)



4 Advanced Operations
Absorbance Ratios (UV2000)

68 SpectraSYSTEM UV/Vis Detectors User Guide Thermo Scientific

Absorbance Ratios (UV2000)
Ratioing the detector's outputs from two different wavelengths can be a useful way of 
confirming peak purity. When a peak is pure, the ratio of the absorbances should remain 
constant. Thus, the ratio for a pure compound produces a relatively square wave, while the 
ratio for an impure compound produces a distorted wave (see the plots at 1.57 and 
0.97 minutes, respectively, in Figure 92). 

Figure 92. Using absorbance ratios to determine the purity of two peaks in a chromatogram

To use absorbance ratioing, you need to select AU1/AU2 for the Analog 2 Output field in the 
Analog Outputs Menu. You also need to select the two wavelengths you want to ratio.

To select the most appropriate wavelengths, use the UV2000's Scan File to collect a spectrum 
across a range of wavelengths. Then select /Display AU/, from the Replay Menu and examine 
the collected data.

The data shown in Figure 93 are typical.

Time (in minutes)

1.570.97

Mixture of 
two compounds

Pure
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AU1?AU2 Plot
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Figure 93. The Display AU, λ screen

Ratioing only occurs when the absorbance value for each wavelength exceeds 12.5% of the 
corresponding range value. So, in our example, if Ranges 1 and 2 were set to 1.0 in the 
FILES > Edit > Options Menu, the 250 and 280 nm wavelengths could be ratioed. [Twelve 
and a half percent of 1.0 (the range) is 0.125. Absorbance values less than 0.125 are too low 
for ratioing.] No ratio output is produced when the absorbance values fall below 7.5% of the 
range values.

Generally, good wavelengths to choose are:

• the lambda max of the main peak (AU1)

• a wavelength with an absorbance value less than the lambda max but greater than 12.5% 
of the corresponding range (AU2)

Whichever wavelengths you choose, don't select a wavelength that has a low absorbance value. 
Low absorbance values decrease the signal-to noise ratio, thus making the absorbance ratios 
less meaningful. Similarly, a small fluctuation in AU2 results in a big difference in the 
absorbance ratio if AU2 is very small. Fortunately, by relying on the preset range values, the 
UV 2000 has a built-in safeguard that prevents the ratioing of low absorbance values.

Tip  A good rule of thumb is to select a second wavelength that is either half the height of 
the lambda max or more than ten nanometers removed from the lambda max.
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5

Required Maintenance

The SpectraSYSTEM UV1000 and UV2000 detectors are finely-tuned scientific instruments 
that we at Thermo Fisher Scientific are proud to stand behind. Even so, routine maintenance 
is necessary to ensure peak performance, so we can only guarantee the performance of the 
detector if you follow proper care and maintenance procedures.

This chapter shows you how to replace and clean your detector's flowcell and lamps.

Also included in this chapter is a procedure for testing the detector's absorbance linearity. This 
characteristic is particularly useful if your laboratory's standard operating procedures require 
periodic detector validation. You will need the optional cuvette holder to perform the test.

If you have any questions on proper maintenance or would like to arrange for a preventive 
maintenance program, please contact your local Thermo Fisher Scientific representative.

Flowcells
This section describes the changing and general cleaning of your detector's flowcell. For other 
flowcell problems, such as a cracked window or leaks that occur in locations other than at the 
inlet/outlet fittings, contact your Thermo Fisher Scientific representative.

Changing the Flowcell

The flowcell needs to be removed whenever you replace a broken cell, change specialized 
applications, or clean the cell with nitric acid. For a list of available flowcells, see “Optional 
Flowcells” on page 94. All flowcells are shipped premounted in a holder for easier installation 
and alignment.

Contents

• Flowcells

• Lamps

CAUTION  Flowcells are factory-assembled units that should not be disassembled under 
any circumstance.
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To access the flowcell, remove the front panel of the detector. The flowcell assembly is located 
behind the lower housing (Figure 94). Once the housing is removed, the flowcell is easily 
identified by the tubing that extends from the fittings on either side of the cell body 
(Figure 95).

Figure 94. Detector flowcell and lamp housings
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Flowcell Removal

To remove the flowcell

1. Disconnect the power cord from the rear panel of the detector and make sure that the 
instrument is turned off.

2. If you have not already done so, remove the detector's front panel by grasping the bottom 
of the panel firmly with one hand and pulling back.

3. Loosen the knurled thumbscrew that holds the flowcell housing in place, and remove and 
set aside both the thumbscrew and the housing.

4. Disconnect the flowcell inlet tube from the chromatograph and free the flowcell outlet 
tubing from the waste reservoir.

5. Loosen the two thumbscrews on the photodiode mount and carefully pull the mount 
straight back (Figure 95). The cable that connects the photodiode mount to the detector 
is sufficiently long to allow the mount to rest on the bench top.

Figure 95. Removing the cell cover to expose the flowcell and the photodiode mount

6. Loosen the thumbscrew that holds the tubing clamp in place. Gently pull the clamp 
toward you just far enough to disengage the tubing.

7. Loosen the two thumbscrews that hold the flowcell assembly. Carefully pull the assembly 
toward you to remove it from the detector.

Note  Avoid putting fingerprints or scratches on the flowcell windows, photodiode 
surface, or monochromator lens, all of which are exposed during these procedures. If 
dirty, the surfaces should be cleaned with spectroscopic-grade methanol (or 
isopropanol) and lint-free lens paper only.

RUN

STOP

ST ATUS MENU

ENTER

Flowcell assembly 
thumbscrews

Flowcell outlet

Photodiode mount

Flowcell inlet

Tubing clamp

Flowcell
assembly
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Flowcell Installation

To install a flowcell

1. With the inlet tube on the bottom, slide the flowcell assembly onto the alignment pins 
(Figure 96) and securely fasten it in place with the two thumbscrews.

Figure 96. Installing the flowcell assembly

2. Slip the flowcell's inlet and outlet tubes into the slots of the tubing clamp and tighten the 
thumbscrew that holds the clamp in place.

3. Replace the photodiode mount and fasten it securely with the two thumbscrews.

4. Connect the inlet tubing to the chromatographic column and the outlet tubing to the 
waste reservoir.

5. Taking care not to pinch the cable or tubing, replace the flowcell housing and secure it 
with the knurled thumbscrew. Replace the detector's front cover.

6. Connect the power cord to the rear detector panel.

Flowcell alignment 
pins

Tubing clamp

Photodiode 
mount

Flowcell
assembly
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Cleaning the Flowcell

The exterior and/or interior surfaces of the flowcell can become contaminated. When flowcell 
contamination occurs, it is usually caused by precipitation or solubility problems, such as 
when the quality of your mobile phase solvent components and the cleanliness of your 
samples are variable. Signs of a contaminated flowcell are increased baseline noise, signal 
spiking, erratic or drifting baselines, and increased backpressure.

Cleaning with Organic Solvents

If you suspect that your flowcell needs to be cleaned, start with the following procedure using 
organic solvents.

To clean with organic solvents

1. Make certain that the cleaning solvent(s) you plan to use is/are miscible with the solvent 
already present in the flowcell and pump. Isopropanol is a good choice for most 
applications.

2. Flush the flowcell with 40 to 50 milliliters of solvent (HPLC-grade water, methanol, or 
isopropanol). You can either pump the solvent through the flowcell with the 
chromatographic pump, or you can draw the solvent through the flowcell using a 
large-volume syringe.

If you use an LC pump to flush the flowcell, first remove the column from your 
chromatographic system to avoid column degradation. Replace the column with an 
appropriate length of tubing, ensuring that all connections are snug and leak-free. If you 
use a syringe, always draw the solution through the flowcell.

CAUTION  Flowcells are factory-assembled units that should not be disassembled under 
any circumstance. If you encounter contamination problems that are not remedied by this 
cleaning procedure, contact your local Thermo Fisher Scientific representative to arrange 
for repair or replacement.

IMPORTANT  If the last solvent in the pump was an aqueous buffer solution, be sure 
to pump 25 - 40 mL of HPLC-grade water (or equivalent) through the system to 
remove any salts before flushing with the cleaning solvent(s).

CAUTION  Never use a syringe to force solvent through a flowcell. Pressurizing the 
syringe could cause a leak or rupture that would result in an extremely dangerous, 
uncontrolled spraying of solvent.
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Cleaning with Nitric Acid

Methanol or isopropanol is generally sufficient for cleaning a flowcell. However, if the flowcell 
is still contaminated after flushing with organic solvents, follow this nitric acid procedure.

To clean with nitric acid

1. Remove the flowcell assembly from the detector housing (see “Flowcell Removal” on 
page 73) before cleaning with a nitric acid solution. This will prevent possible leaks from 
harming the mechanical or electronic components of the detector. 

2. Flush the flowcell with water before proceeding. This step is very important.

3. Prepare a 20% (v/v) solution of nitric acid in HPLC-grade water. 

4. Pump the nitric acid solution through the flowcell with the chromatographic pump or 
draw it through with a large-volume syringe. 

If you use an LC pump, replace your column with tubing and make sure water was the 
last solvent in the pump and solvent reservoir. If you use a syringe, always draw the 
solution through the flowcell.

5. After you have finished the cleaning procedure and before returning to the buffer 
solution, pump another 25 to 40 mL of water through the flowcell to remove all traces of 
nitric acid before returning to your chromatographic solvents. Reinstall the flowcell 
assembly.

CAUTION  Nitric acid is extremely corrosive and can react explosively with alcohols 
(especially methanol). Be sure to adhere to your company's safety procedures for 
handling and disposal of corrosive acids. Flush the flowcell with water to remove all 
traces of alcohol prior to flushing with nitric acid.

CAUTION  Never use a syringe to force nitric acid through a flowcell. Pressurizing the 
syringe could cause a leak or rupture that would result in an extremely dangerous, 
uncontrolled spraying of nitric acid. 

IMPORTANT  Flush the pump with water immediately after the nitric acid flush. 
Leaving nitric acid solution in the pump for prolonged periods can damage pump 
seals.
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Lamps
As lamps age, there is a reduction in light output that results in increased baseline noise. If the 
noise level on your detector's output signal is increasing and cleaning the flowcell doesn't 
help, you should change the appropriate lamp, using the procedures in this section.

Remove the front panel of the detector. The deuterium and tungsten lamps are located in the 
upper housing (Figure 97). Both lamps are supplied prealigned in their individual assemblies 
to make them easy to install and align.

Figure 97. Location of lamp housing

IMPORTANT  Never loosen the screws that hold the lamp to its assembly or attempt to 
rotate or move the lamp up or down in the assembly. Either of these actions can cause a 
loss of alignment and degrade the system's performance.
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The Deuterium Lamp

The deuterium (D2) lamp typically requires a warm-up time of twenty to thirty minutes. 
However, for applications that demand great sensitivity, you might want to allow a warm-up 
period of up to an hour.

The deuterium lamp's lifetime is usually at least 1000 hours. Each D2 lamp assembly is 
equipped with a chronometer (Figure 98) that tracks the total hours of lamp operation. To 
read the chronometer, note the position of the "gap" in the mercury tube against the 
graduated background. You can also track lamp life automatically. (See “Automatic Lamp 
Operations” on page 43 for details.)

Figure 98. Deuterium lamp chronometer

D2 Lamp Removal

To remove the deuterium lamp

1. Disconnect the power cord from the detector's rear panel and make sure that the 
instrument is turned off.

2. If you have not already done so, remove the detector's front panel by grasping the bottom 
of the panel firmly with one hand and pulling back.

IMPORTANT  The lamp surface must be kept free of fingerprints and smudges. If the 
surface needs cleaning, use a lint-free lens paper moistened with methanol or isopropanol.

Plug-in 
connector

Gap

Lamp leads

CAUTION  Intense UV light can damage your eyes. Always disconnect the power cord 
before exposing the lamp and always allow sufficient time for the lamp to cool before 
removing it, as it gets quite hot when lit.
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Figure 99. Deuterium and tungsten lamp assemblies

3. Remove the lamp housing by loosening the thumbscrew and pulling the cover straight 
back to expose the lamp assemblies (Figure 99).

4. Unplug the deuterium lamp lead from the detector, taking care not to twist the connector 
as you gently pull it out.

5. Loosen the two thumbscrews that hold the lamp assembly in place and pull the assembly 
straight out.
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D2 Lamp Installation

To install a new D2 lamp

1. Hold the deuterium lamp assembly so that the leads are at the top. Slide the assembly 
onto the alignment pin shown in Figure 100. (The alignment pin is located directly 
below the detector's monochromator aperture.)

2. Securely fasten the assembly in place with the two thumbscrews and aluminum standoffs.

3. Connect the lamp lead to the right-hand terminal in the lamp compartment.

4. Replace the lamp housing and secure it with the knurled thumbscrew. Replace the 
detector's front cover.

5. Connect the power cord to the rear detector panel.

Figure 100. Deuterium and tungsten lamp alignment pins

The Tungsten Lamp

The tungsten (W) lamp typically requires only fifteen minutes of warm-up time. Its lifetime is 
approximately 2500 hours. You can track lamp life automatically. (See “Automatic Lamp 
Operations” on page 43 for details.)

W Lamp Removal

To remove the tungsten lamp

1. Disconnect the power cord from the detector's rear panel and make sure that the 
instrument is turned off.

Tungsten lamp
alignment pins

Deuterium lamp
alignment pin

CAUTION  Hot Surface. Avoid burns. Always allow sufficient time for the lamp to 
cool before removing it.
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2. If you have not already done so, remove the detector's front panel by grasping the bottom 
of the panel firmly with one hand and pulling back.

3. Remove the lamp housing by loosening the thumbscrew and pulling the cover straight 
back to expose the lamp assembly (Figure 100).

4. Unplug the tungsten lamp lead from the detector, taking care not to twist the connector 
as you gently pull it out.

5. Loosen the thumbscrew and the aluminum standoff that hold the lamp assembly in place 
and pull the assembly straight out.

W Lamp Installation

To replace the tungsten lamp 

1. Hold the lamp assembly so that the leads are at the top. Slide the assembly onto the two 
alignment pins shown in Figure 100. (The alignment pins are located on either side of the 
detector's monochromator aperture.)

2. Securely fasten the assembly in place with the thumbscrew and aluminum standoff.

3. Connect the lamp lead to the left-hand terminal in the lamp compartment.

4. Replace the lamp housing and fasten securely with the thumbscrew.

5. Connect the power cord to the rear detector panel. 





Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 83

6

Installation and Specifications

This chapter covers the initial installation of your UV/Vis detector, including hookup to other 
chromatographic instrumentation. As you go through unpacking and installation, you might 
want to use the Start-up Checklist located at the beginning of this manual. The checklist is an 
abbreviated version of this chapter and is supplied as a quick reference of how to conduct a 
successful installation. After installation, verify that the detector is working properly by 
running the two tests described on “External Diagnostic Tests” on page 122.

Also included in this Chapter is a list of your detector's specifications.

Installation Checklist
Use this checklist to ensure that you have completed all the steps necessary for the proper 
installation of your SpectraSYSTEM UV/Vis detector.

Contents

• Installation Checklist

• Unpacking

• Checking the Power

• Making Rear Panel Connections

• Connecting to the Flowcell

• Specifications



6 Installation and Specifications
Installation Checklist

84 SpectraSYSTEM UV/Vis Detectors User Guide Thermo Scientific

The following installation checklist is a brief summary of the steps that you need to complete 
in sequence for the proper installation of the PDA detector.

Unpacking

Unpack and inspect your instrument. Check for damage.

Check your accessory kit and manual:

present?

complete?

Read the Safety Information Card.

Positioning Detector

Place on benchtop as close as possible to the column and at least 5 in. (13 cm) from the 
wall.

Power Checkout

Set voltage for local requirements.

Check that the correct fuses are installed.

Rear Panel Connections

Insert the 8- and 12-pin green connectors into their corresponding sockets.

Connect the Analog Output and the corresponding ground terminals to your data 
system/recorder.

Connect the desired remote communications terminals to external devices:

STOP (Input)

RUN (Input)

ZERO (Input)

READY (Output)

Connect the power cord.

Flowcell Connections

Remove the detector's front panel.

Remove the flowcell assembly from the detector.

Connect the flowcell inlet directly to your LC column outlet.

Connect the flowcell outlet to waste tubing and a waste container.

Replace the detector's front panel.

Instrument Power-up

Install the power cord and turn on the instrument.

Check that self-tests are running and that no error messages appear.
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Unpacking
Carefully remove the detector from the shipping container and inspect both the detector and 
packing for any signs of damage. If you find any damage, immediately contact the shipping 
company.

The shipping container should contain the detector, an accessory kit, any options you ordered 
for your detector, and this manual. The accessory kit should contain the following items:

• 8-pin connector

• 12-pin connector

• Nut and ferrule tubing set

• Teflon tubing

• Nut fitting for 1/16-in. OD high-pressure tubing (1/4-28 thread)

• Ferrule fitting for 1/16-in. OD high-pressure tubing

• Union

• External run/autozero cable

• Analog cable

• Extra cap screws (2)

• LC test mix vial

• 3-foot, 4-conductor cable

Carefully check to make sure you received all the items listed on the packing list. If any items 
are missing, contact your Thermo Fisher Scientific representative immediately.

Check that the Status Screen appears on display.

Registration Card

Complete and return the registration card.

This detector was installed by:

(Name) (Date)
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You will need the following tools for installation:

• a narrow-tip screwdriver (2 mm wide)

• a #2 Phillips screwdriver

Place the detector on the benchtop as close as possible to the chromatographic column outlet 
(thus minimizing the length of tubing necessary for connection to the flowcell inlet). Allow at 
least five inches (13 cm) of clear space between the detector's rear panel and any wall or 
obstruction. This provides both access to the rear-panel connectors and a free flow of 
cooling air.

Checking the Power
The detector is shipped with the voltage and fuses preset for your location. To verify the 
correct setting, look through the cut-out window on the voltage selector cover (Figure 101). 
(The cover is located on the detector's rear panel but, if your instrument is new, it might be 
hidden behind a precautionary sticker.) If the voltage setting satisfies you local site 
requirements, skip to “Fuses” on page 88. If not, proceed to the next section, Voltage 
Selection.

Voltage Selection

If the preset voltage does not satisfy your local requirements, select the correct voltage.

To select the correct voltage

1. Insert a small flat-blade screwdriver into the slot at the top of the voltage selector cover 
(Figure 101).

CAUTION  Do not plug in the instrument without first verifying that the voltage is 
properly set for your location. And never run the detector at more than 10% below the 
nominal line voltage.
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Figure 101. Opening the voltage selector cover

Figure 102. Voltage selector barrel and fuse holders

2. Gently pry open the cover. Once unlatched, the cover will swing downward to reveal the 
voltage selector barrel and the fuses.

3. Remove the voltage selector barrel from the detector. The selector resembles a wheel with 
four settings: 100, 120, 220, and 240 V (Figure 102).

4. Rotate the barrel such that the desired voltage setting will be visible through the cut-out 
in the cover when it is replaced.

5. Replace the barrel in the detector. Before closing the cover, check the fuses according to 
the procedure on page 88.

220V ac

Pry open here

Current voltage
selection

Fuse holder

Voltage selector drum
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Fuses

To verify that your detector is fitted with the correct fuses

1. Pull each fuse holder straight towards you. The fuse holders are the black squares with 
arrows located directly beneath the voltage selector (Figure 102).

2. Remove each fuse from its holder. Check the fuse amperage, voltage, and type according 
to the following description. You should have either:

• two T2A/250V fuses, for 100 - 120 VAC operation, or

• two T1A/250V fuses, for 220 - 240 VAC operation

Figure 103. Fuses

3. Assuming that you have the proper fuses on hand, reinsert the fuses and fuse holders, 
making sure that the arrows on the holders are oriented in the same direction as the arrow 
inside the cover panel (Figure 103).

4. Close the cover panel by swinging it upward and pressing it in until it snaps closed. The 
correct voltage should appear in the cut-out panel.

Power Cord

Attach the power cord at the lower left of the detector's rear panel.

IMPORTANT  If you haven't verified that your detector is fitted with the correct fuses, first 
open the voltage selector cover according to step 1 in the Voltage Selection procedure.

Fuse holders Fuse

Door of power-entry module

CAUTION  To avoid damaging the instrument, verify that the new voltage setting 
(displayed in the cut-out window) is correct before you turn it on.
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Making Rear Panel Connections
Locate the two connectors (8-pin and 12-pin) in your accessory kit and insert them in the 
appropriate sockets on the detector's rear panel (Figure 104). Note that the connectors are 
both labeled and keyed to the sockets, making it impossible to insert them incorrectly.

Figure 104. Analog output and remote communications connectors

The upper connector holds the detector's analog output terminals. The lower connector 
allows the detector to communicate with other devices in your liquid chromatographic 
system. There is also a communications port, labeled COMM.

Use the cables supplied with your detector to make the connections described in this section. 
For each connection, insert the cable's bare wire into the appropriate detector terminal. Hold 
the wire in place while you tighten the small setscrew located next to each opening.

D
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UV2000 Analog Output Connections

The terminals on the UV2000's analog output connector are labeled ANLG 1 Output and 
ANLG 2 Output (Figure 104). Each output has four terminals, labeled H through E for 
Output 1, and D through A for Output 2. These terminals correspond to:

• 0.01 V full-scale (terminals H and D)

• 0.10 V full-scale (terminals G and C)

• 1.0 V full-scale (terminals F and B)

• Ground (terminals E and A)

UV1000 Analog Output Connections

The terminals on the UV1000's analog output connector are labeled UNRANGED Output 
and RANGED Output (Figure 104). The UNRANGED Output is a 1 AU/VOLT 
unrangeable output primarily used for integrators and workstations. The UNRANGED 
Output can be connected to terminal F with a ground at terminal E or A. The RANGED 
Output has four terminals:

• 0.01 V full-scale (terminals H and D)

• 0.10 V full-scale (terminals G and C)

• 1.0 V full-scale (terminals F and B)

• Ground (terminals E and A)

IMPORTANT  Analog outputs are driven to twice their range. In other words, their 
maximum output is twice the selected range. To avoid clipping the voltage, be sure to 
connect integrators and data systems to the 1.0 V terminal and to use caution when 
connecting recorders to the 0.01 or 0.10 V terminals.

Integrators/Workstations For the UV2000, connect your integrator/workstation to 
the 1.0VF/S (F or B) and corresponding ground (E or A) 
terminals. 

Recorders Connect the positive input from your recorder to the 
full-scale voltage (0.01, 0.10, or 1.0 V) appropriate for 
your recorder. Connect the recorder's floating ground 
input to the corresponding GROUND terminal.

Note Do not connect the detector's GROUND to any 
earth ground on your recorder. This would lead to an 
increased noise level and a subsequent decrease in 
sensitivity.
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Remote Communications Connections

Your detector can accept inputs from, and send inputs to, remote devices through the remote 
communications connector (Figure 104). For example, if your chromatographic system has 
programmable timed events (contact closures or TTL), you can use one to automatically zero 
the detector signal during a run.

The terminals available on the detector's remote communications connector are labeled 
STOP (Input), RUN (Input), ZERO (Input), and READY (Output), each with an associated 
ground terminal. The terminals are labeled 12 through 1. 

Integrators/Workstations For the UV1000, connector your integrator/workstation 
to the 1AU/V output terminal (F) and the ground (E) 
terminal.

Recorders Connect the positive input from your recorder to the 
full-scale voltage (0.01, 0.10, or 1.0 V) appropriate for 
your recorder. Connect the recorder's floating ground 
input to the corresponding GROUND terminal.

Note Do not connect the detector's GROUND to any 
earth ground on your recorder. This would lead to an 
increased noise level and a subsequent decrease in 
sensitivity.

STOP (Input) You can use a timed event from your chromatographic system to 
take the detector out of run by connecting the system's event to 
the detector's STOP (Input) and GROUND terminals 
(terminals 12 and 11).

RUN (Input) You can use the remote-start event on your injector or 
autosampler to automatically put the detector into run whenever 
an injection occurs by connecting the event to the detector's RUN 
(Input) and GROUND terminals (terminals 10 and 9).

ZERO (Input) You can zero the detector signal automatically by connecting a 
timed event on your chromatograph to the detector's ZERO 
(Input) and GROUND terminals (terminals 8 and 7).
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READY (Output) The detector is capable of driving one TTL load each time it goes 
to its READY state through the READY (Output) terminal. This 
ability to signal other instruments is particularly useful with 
autosamplers, where the detector can signal that it is ready for the 
next injection in an automated series of runs. To hook up the 
READY (Output) terminal, connect the input from the other 
instrument to the detector's READY (Output) and GROUND 
terminals (terminals 4 and 5). For more information on accessing 
this feature through the detector's keypad, see “Ready Output” on 
page 46.
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Connecting to the Flowcell
To connect the flowcell

1. Remove the front panel of the detector. Although the flowcell assembly is located behind 
the lower housing (Figure 105), the housing does not need to be removed to connect your 
inlet and outlet lines.

Figure 105. The flowcell assembly is located behind the flowcell housing

2. Use the finger-tight fitting and ferrule sets included with the installation kit to connect 
the column outlet directly to the detector's flowcell (fluid) inlet. Figure 106 shows how 
the inlet line enters the detector from the left side, and winds around the flowcell before 
entering the flowcell from the bottom.

IMPORTANT  If additional tubing is required to reach the inlet, use a zero 
dead-volume union.

RUN

STOP

MENU

E N T E RENTER

ZERO UV2000SpectraSYSTEM

STATUS

Display

Keypad

Lamp housing

Flowcell housing
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3. Connect the detector's fluid outlet to the low-pressure union and waste tubing supplied 
in the installation kit. 

4. Replace the front panel of the detector; making sure that the tubing passes through the 
slots without being pinched.

Figure 106. The flowcell assembly showing thumbscrews, photodiode mount, and flowcell inlet

Optional Flowcells

Thermo Fisher Scientific offers several different flowcells for use in different applications. 
Each flowcell possesses distinct design characteristics and performance specifications. These 
characteristics are compiled in Table 1. Contact your Thermo Fisher Scientific representative 
for details. 

Tip  If you have several detectors (fluorescence, refractive index, electrochemical, and 
so on) hooked up in series, place your UV2000 detector closest to the column outlet, 
as its flowcell can withstand the greatest backpressure.

RUN

STOP

ST ATUS MENU

ENTER

Flowcell assembly 
thumbscrews

Flowcell outlet

Photodiode mount

Flowcell inlet

Tubing clamp

Flowcell
assembly

Table 1. Design and performance specifications for SpectraSYSTEM flowcells*

Path Flowcell Path Length 
(mm)

Volume
(μL)

Tubing 
Diameter.
(in.)

Material** Max. Flow 
(mL/min)

Max. Press. 
(psi)

Analytical LC 6 9 .01 SS1 50 1000

Analytical LC 10 15 .01 SS1 50 1000

Microbore 3 1.2 .005 SS1 10 1000

Microbore 6 7.0 .007 SS1 20 1000

Semi-Prep. 
Open Column

3 4.5 .02 SS1 100 1000

*All cells use sapphire for windows. All but the preparative flowcells have a heat exchanger.
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Flowcell Orientation

The flowcells listed above are configured for use with any SpectraSYSTEM detector. These 
detectors are vertically-oriented detectors that have the tubing clamp located above the 
flowcell as shown in Figure 107.

If you plan to use any of these flowcells on non- SpectraSYSTEM detectors (primarily 
horizontally-oriented detectors that have their tubing clamps located to the left side of the 
flowcell as shown in Figure 108), you must realign the cell holder as described in the following 
instructions.

Figure 107 shows the flowcell as it is shipped. Figure 107 and Figure 108 show the tubing 
clamp as an aid to the proper positioning of the inlet and outlet tubes. The tubing clamp, 
however, is actually mounted onto the detector and is not part of the flowcell itself.

Figure 107. The alignment of UV2000 flowcells as they are shipped

**SS1 = Stainless Steel with TFE Gaskets.

IMPORTANT  To ensure proper alignment, always hold the cell holder and flowcell in the 
orientation shown in the illustrations.

A

Photodiode 
standoffs

Inlet tube

Tubing clamp
(on vertically-oriented

detectors)

Outlet tube

Mounting screws
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To realign the cell holder

1. Remove the mounting screws and set them aside.

2. Rotate the cell holder 90 degrees counterclockwise. Do not rotate the cell body. Part B of 
Figure 108 shows the cell holder in its new position. Note the new position of the 
photodiode standoffs.

Figure 108. Changing the alignment of a flowcell so that it can be used on other detectors 
(Turn the cell holder as shown in Part B. Align the inlet and outlet tubes with the 
tubing clamp as shown in Part C.)

3. Reattach the cell body by replacing and securing the mounting screws.

4. Gently bend the inlet and outlet tubes as shown in Part C of Figure 108. The inlet tube 
(wound around the cell body) should always enter at the bottom of the flowcell; the 
outlet tube should always exit at the top of the flowcell.

B C

Mounting screw
holes

Photodiode
standoffs

Cell holder

Inlet tube

Outlet tubeTubing clamp
(on vertically-oriented

detectors)



 6 Installation and Specifications
Specifications

Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 97

Specifications
Wavelength: D2 lamp 

• 190 to 380 nm (UV1000) 
• 190 to 365 nm (UV2000)

W lamp
• 366 to 800 nm

Lamp(s): UV1000: D2 standard, W optional
UV2000: D2 and W standard

Bandwidth: 6 nm

Wavelength Accuracy: ±1.0 nm

Wavelength Precision: ±0.1 nm

Range Selections: 3.0, 2.0, 1.0, 0.5, 0.2, 0.1, 0.05, 0.02, 0.01, 0.005, 
0.002, 0.001, 0.0005 AUFS

Absorbance Range: 0.0005 to 3.0 AUFS

Absorbance Linearity @ 254 nm: Better than 1% to 2.0 AU

Analog Outputs: (UV2000) Outputs 1 and 2: Range-selectable over 
entire absorbance range

Communications: Remote Inputs: Run, Stop, and Zero
Remote Outputs: Ready

Noise: Single-wavelength Mode:
• @ 254 nm, 1.0-sec rise time: < ±1.0 × 10 -5 AU

Dual-wavelength Mode:
• @ 254 280 nm, 1.0-sec rise time (UV2000 only): 

< ±2.5 × 10 -5 AU

Drift: After warm-up @ 254 nm: < 2 × 10 -4 AU/hour

Display: 2 × 24 character, high-contrast LCD

Dimensions: 14.5 in. (37 cm) × 6 in. (15 cm) × 18.5  in. (47 cm)

Weight: 40 lb. (18 kg) 

Power Requirements: 100/120/220/240 
VAC 50/60 Hz
1.5/1.6/8.0/0.8A, 225VA

Environmental: 10-40 °C
5-95% RH noncondensing





Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 99

7

Menu Reference

This chapter provides you with two Menu Trees, one each for the UV1000 (Figure 109) and 
the UV2000 (Figure 110 and Figure 111). It also provides you with an alphabetical 
description of all the instrument's display fields. Fortunately, it is not necessary to read this 
Chapter in order to learn how to use your detector. It is included in the manual simply as a 
quick reference and aid to using your instrument.

The Menu Trees are a representation of the detector's overall menu structure. They show the 
location and interrelation of all the menus for your detector and, as such, they are a good 
reference to keep on hand while you work through the operating instructions in Chapter 3 
and Chapter 4. The menu trees will also help if you become "lost" while moving through the 
detector's menus. Separate, removable copies can be found in the pocket at the front of this 
manual.

The Menu Reference is an alphabetical listing of each menu field and command. Included in 
each listing is the field's definition and, where appropriate, all allowable and default values.

Menu Trees
The UV1000 and UV2000 Menu Trees are useful tools for learning your way around your 
detector. You might want to keep one handy while you learn where each display is located in 
the overall menu structure.

Menu Reference
For quick reference, we have included this alphabetical list of each field, including a short 
definition, and allowable and default values. For a more detailed explanation of the functions 
of your detector, you should refer to Chapter 3, “Basic Operations,” and Chapter 4, 
“Advanced Operations.” 

Some fields are common to both the UV1000 and the UV2000, so we have indicated the 
detector name for fields that appear in only one detector.
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Table 2. Menu Reference  (Sheet 1 of 7)

Fields Description

Analog 1 Offset (mV) (UV1000 only) This field offsets the Analog 1 output signal by 0, 1, 2, 5, 10, 20, or 
50 mV. The default setting of 10 mV is appropriate in most cases.

Analog 1 Offset (%) (UV2000 only) This field offsets the Analog 1 output signal by a positive or negative 
50, 20, 10, 5, 2, 1, or 0 percent of the full-scale range. Default is 0%. 

Analog 2 (UV2000 only) This field allows you to select the output signal from the Analog 
Output 2 terminal. The selections are AU (the absorbance signal for wavelength one in 
single-wavelength operation or from wavelength two in dual-wavelength operation), 
AU1-KxAU2 (a calculated peak response using the K Factor technique), and AU1/AU2 
(the absorbance ratio of wavelength 1 to wavelength 2). Default is AU. 

Analog 2 Offset (%) This field offsets the Analog 2 output signal by a positive or negative 50, 20, 10, 5, 2, 1, 
or 0 percent of the full-scale range. Default is 0%.

Analog Outputs This menu allows you to offset the signals from the analog output terminals located on 
the back panel of the instrument. For the UV2000, you can also select the output signal 
for Analog Output 2 and input a K factor.

AU This field, located in the Status Screen, shows the detector's current absorbance reading. 
It is a six-digit number, ranging from -3.00000 to +3.00000 AUFS.

Autozero Time This field tells the detector when to perform an automatic zero. Allowable values are 
0.00 to 999.99 minutes. Default is 0.00 minutes.

COMMANDS The Commands Menu lets you put an event mark into your chromatogram, short 
detector outputs, and shut down the detector.

Copy (UV2000 only) This field accesses the Copy File field.

Copy File (UV2000 only) This field, along with the To File field, allows you to copy from the 
specified file to another file designation.

Current Time This field displays local time ranging from 0:00 to 23:59.

Cursor Speed This field can be set to Slow, Medium, or Fast according to your need. Default is 
Medium.

Delete Under the top-level menu FILE(S), this field accesses the Delete File command.

(UV2000 only) Under the top-level menu QUEUE, this field accesses the Delete 
Queue command.

Delete File This field deletes the designated file, setting all fields to their default values. After 
pressing ENTER, the confirmation message **File Deleted** appears for one second.

Delete Queue (UV2000 only) This field deletes the queue. After pressing ENTER, the confirmation 
message **Queue Deleted** appears for one second.

D2 Lamp Hours This field tracks the total number of hours the detector's deuterium lamp has been in 
operation (up to 9999). When a new lamp is installed, you must set this parameter to 
zero.
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Diode Offsets This field displays the analog-to-digital (A/D) conversion frequencies of the sample and 
reference diodes when both lamps are turned off. These values can be used to measure 
the detector's digital noise level.

Display AU, λ This command calls up the Display AU, λ screen, a screen that shows the incremental 
wavelength versus absorbance data for the selected spectral scan. 

Edit Under the top-level FILE(S) menu, the Edit Menu allows you to set up or edit files. The 
edits do not change the current settings of the detector until the file is loaded.

(UV2000 only) Under the top-level QUEUE menu, the Edit Menu allows you to set up 
or edit a Queue. Edits can not be made to Order 1 while a queue is loaded or running 
unless you pause the queue first.

Edit File (UV2000 only) This field allows you to identify the file for set up or edit. Allowable 
designations are 1 to 4, S for the Scan file, and D for the Develop file. Default is 1. 

End λ (UV2000 only) In the Scan File Setup, this field defines the wavelength at which the 
detector should finish the scan. Allowable values are 191 to 800 nm. Default is 350 nm.

(UV2000 only) In the Develop File Setup, this field defines the wavelength at which the 
detector should run its last set of injections. Allowable values are 191 to 800 nm. 
Default is 350 nm. 

Event Mark The Event Mark field applies a 15% of full-scale spike on the detector's output signals.

FILE(S) The UV1000's FILES Menu and the UV2000's FILES Menu allow you to edit, load, 
and delete files. On the UV2000, the FILES Menu also lets you copy files.

File Name (UV2000 only) This field allows you to enter a file name for a designated file 
(numbered 1 to 4). The name can contain up to eight characters from the following list: 
A to Z, 0 to 9, /, -, and blank. Default is blank. 

(UV2000 only) For Files S and D, the file names are automatically designated as SCAN 
and DEVELOP, respectively. No editing of these file names is allowed. 

K Factor (UV2000 only) This field is used in the technique. Allowable values are -99.999 to 
99.999. Default is 1.000.

λ (λ1, λ2) The wavelength field (λ in the UV1000, λ1, λ2 in the UV2000) located in the Status 
Screen shows the current detector wavelength setting(s).

(UV2000 only) These fields also appear in the Wavelength Program for 
dual-wavelength operation.

λ Calibration The wavelength calibration screen located in the Tests Menu shows the current detector 
wavelength setting(s).

Table 2. Menu Reference  (Sheet 2 of 7)

Fields Description
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λ Interval (UV2000 only) In the Scan File Setup, this field defines the wavelength interval at 
which the detector should perform the scan. Allowable values are 1, 2, 3, 4, 5, and 
10 nm. Default is 5 nm. 

(UV2000 only) In the Develop File Setup, this field defines the wavelength increment 
the detector monochromator should use for wavelength changes between each set of 
injections. Allowable values are 1, 2, 3, 4, 5, 10, and 20 nm. Default is 5 nm.

λMax (UV2000 only) This field is the wavelength maximum in a spectral scan. 

λMaxAU (UV2000 only) This field is the absorbance value for the corresponding wavelength 
maximum in a spectral scan.

λMin (UV2000 only) This field is the wavelength minimum in a spectral scan. 

λ Offset The lambda offset screen lets you choose a number of steps, each representing 0.25 nm, 
by which you want to offset the wavelength. This field is used to check the detector's 
wavelength accuracy. Allowable entries are: 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, -1, -2, -3, -4, 
-5, -6, -7, -8, -9, and -10. The default is 0.

Lamp The Lamp field allows you to choose from among several selections: D2 (190-380) for 
the UV1000's deuterium lamp; D2 (190-365) for the UV2000's deuterium lamp; 
W (366-800) for the tungsten lamp; D2+W (190-800) for dual-lamp operation 
(UV2000 only); or Off to shut the lamp(s) off. Default is D2 (190-380) or 
D2 (190-365), for the UV1000 and UV2000, respectively.

Lamps The Lamps Menu allows you to control the detector's lamp operations.

Light Levels This field displays the analog-to-digital (A/D) conversion frequencies of the light 
detected by the sample and reference diodes when the D2 lamp is on.

Load Under the top-level menu FILE(S), the Load selection accesses the Load File command. 

(UV2000 only) Under the top-level menu QUEUE, the Load selection accesses the 
Load Queue field. 

Load File The Load File field loads the designated file settings into the active runfile. After 
pressing ENTER, the confirmation message **File Loaded** appears for one second.

Load Queue (UV2000 only) The Load Queue field loads the queue. After pressing ENTER, the 
confirmation message **Queue Loaded** appears for one second. 

More This menu allows you to access the Zero on λ Change, Cursor Speed, Status Lock, and 
READY Output fields. In the UV2000, you can also protect files from this menu.

OPTIONS Found in the Main Menu, the Options Menu allows you to perform lamp and analog 
output operations.

Options The Options selection in the Edit Menu of FILE(S) allows you to edit Rise Time, 
Autozero Time, and Range.

Table 2. Menu Reference  (Sheet 3 of 7)

Fields Description
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Order (UV2000 only) This field designates the order in which the selected files in a queue will 
be run. 

Pause (UV2000 only) This field accesses the Pause Queue command. 

Pause Queue (UV2000 only) This field pauses an active queue. If a file is running, it continues until 
completed, and the detector returns to a READY state. 

Program This field allows you to select single- or dual-wavelength operation. The selection 
toggles between Single λ, Dual λ (190-450) and Dual λ (366-700). Default is Single λ.

Protect (UV2000 only) This field, along with the File Name field, protects a specified file from 
being edited, copied to, or deleted. The field toggles between On, allowing no changes 
to the file, and Off, where changes can be made. Default is Off. 

QUEUE (UV2000 only) The Queue Menu allows you to edit, load, delete, or pause a queue. A 
queue is a series of files that are run in a specific order, and is typically used for 
automated runs. 

Range (UV1000 only) The Range field controls the full-scale output range for the UV1000's 
Analog Output 2 terminal. Allowable full-scale ranges are 3.0, 2.0, 1.0, 0.5, 0.2, 0.1, 
0.05, 0.02, 0.01, 0.005, 0.002, 0.001, and 0.0005 AUFS. Default is 1.0 AUFS. 

Range 1, Range 2 (UV2000 only) The Range 1 and Range 2 fields control the full-scale output ranges for 
the UV2000's Analog Output 1 and Analog Output 2 terminals. Allowable full-scale 
ranges are 3.0, 2.0, 1.0, 0.5, 0.2, 0.1, 0.05, 0.02, 0.01, 0.005, 0.002, 0.001, and 
0.0005 AUFS. Default is 1.0 AUFS. 

READY Output This field is used to communicate with other devices through the detector's READY 
(Output) terminal. This TTL terminal switches the transistor between high and low 
states whenever the detector starts a run. Select "Active Hi" or "Active Lo," for the high 
or low state, respectively. Default is Active Hi.

Replay (UV2000 only) The Replay command sends you to the Replay Menu, from which you 
can set up the parameters for replaying stored spectra. 

Replay Spectra (UV2000 only) This command is used to initiate replay of the designated spectrum.

Replay Rate (UV2000 only) This field designates the rate at which the detector replays a stored 
spectrum. Allowable values are 1, 2, 5, 10, and 20 nm/sec. Default is 5 nm/sec. 

Rise Time This field controls the detector's response time. Rise time is inversely proportional to 
the amount of baseline noise. Allowable values are 0.0, 0.1, 0.2, 0.5, 1.0, 2.0, 3.0, 4.0, 
and 5.0 seconds. Default is 1.0 second.

#Runs (UV2000 only) When this field appears in the Status Screen, the current run and the 
total number of injections to be made at the displayed wavelength appear directly below 
it. The field is updated at the beginning of each injection. 

(UV2000 only) When this field appears in a Queue setup, it displays the number of 
times each file runs in a queue.

Table 2. Menu Reference  (Sheet 4 of 7)
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Run λ (UV2000 only) This field designates the monitoring wavelength to be used when 
running the Scan file. Allowable values are 190 to 800 nm. Default is 254  nm. 

Run Time (UV2000 only) Located in the Develop file, this field is the amount of time designated 
for each chromatographic run. Allowable values are 0.01 to 999.99 minutes. Default is 
10.00 minutes. 

Runs per λ (UV2000 only) Located in the Develop file, this field designates the number of 
injections to be performed at each wavelength increment. Allowable values are 1 to 9. 
Default is 1. 

Scan (UV2000 only) This field appears in the Status Screen when the Scan file is loaded. To 
initiate a scan, move the cursor to this field and press ENTER. 

Scan Zero Time (UV2000 only) This field allows you to set a runtime at which the detector will perform 
a baseline scan automatically. Allowable values are 0.00 to 99.99 minutes. Default 
is 0.00. 

Self-Tests This command tells the detector to run through its internal diagnostic tests.

Setup (UV2000 only) The Setup Menu allows you to set up the parameters in the Scan file. 

Short Outputs This command allows you to short the detector's outputs together. When you select 
Short Outputs, the detector's analog outputs are shorted together (zero volts) and the 
field changes to Unshort Outputs. To remove the short and return the outputs to their 
normal operating state, select Unshort Outputs, and the field changes back to Short 
Outputs. When you leave this screen, the field returns automatically to Short Outputs.

Shutdown This field toggles between Manual (you turn off the lamp manually), Time (the lamp 
turns off automatically at a preset time), Time from READY (as explained under the 
Time from READY field), and End of Queue (the lamp turns off when the queue is 
finished, UV2000 only). Default is Manual.

Shutdown Detector This command shuts down the detector's lamps and motors, leaving the electronics on 
to preserve memory. Press any key to return the detector to the same settings as when 
this field was activated.

Shutdown Time This field displays the local time, ranging from 0:00 to 23:59, at which you have 
programmed the lamp to turn off automatically. Default is 0:00.

Software Version This field displays the EPROM version of your detector's software.

Spectra Time (UV2000 only) This field displays a list of the scans that are currently stored in 
memory. Each scan is identified by the runtime at which it was initiated. 

Start λ (UV2000 only) In the Scan File Setup, this field defines the wavelength at which the 
detector should begin the scan. Allowable values are 190 to 799 nm. Default is 220 nm. 

(UV2000 only) In the Develop File Setup, this field defines the wavelength at which the 
detector should run its first set of injections. Allowable values are 190 to 799 nm. 
Default is 220 nm. 

Table 2. Menu Reference  (Sheet 5 of 7)
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Startup The Startup field toggles between Manual, where you manually turn on the lamp, and 
Time, where the lamp automatically powers up at a preset time. Default is Manual.

Startup Time This field displays the local time, ranging from 0:00 to 23:59, at which you have 
programmed the lamp to start up automatically. Default is 0:00.

Status This field in the Status Screen shows the current condition of the detector. The possible 
conditions are: READY (the selected lamp is lit and ready for initiation of a run), 
NRDY (the detector is set to the wrong lamp for the run-wavelength requested, is 
performing internal tests, or has a possible internal problem), or UVW (the deuterium 
lamp is warming up). The run time is displayed when the running file has a 
programmed stop-time.

In the UV2000, the letter Q appears at the beginning of this field when a queue is 
loaded.

Status Lock The Status Lock field limits accessibility to the Status Menu (the programming section 
below the Status Screen). When set to On, only the Status Screen appears on the display 
and the down-arrow icon is not seen. Default is Off.

TESTS The TESTS menu allows you to perform the detector's internal diagnostic, light level, 
and diode offset tests.

Time, Wavelength The Wavelength Program contains the Time and Wavelength fields. It allows you to 
program changes in the detector's wavelength as a function of time.

Time refers to the run time, in minutes, when a timed event (wavelength change, 
autozero, or run stop) is to occur. Allowable values range from 0.00 to 999.99 minutes. 
Default is 0.00 minutes.

Wavelength refers to the wavelength that will be set at a specified time. Allowable values 
for the UV1000 are: 190 to 380 nm with the deuterium lamp, and 366 to 800 nm with 
the tungsten lamp. Allowable values for the UV2000 are: 190 to 365 nm with the 
deuterium lamp, and either 366 to 700 nm or 366 to 800 nm with the tungsten lamp 
(depending on whether the detector is operating in the dual-wavelength or the 
single-wavelength mode, respectively). Default is 250 nm.

Time from READY A preset time interval from the Ready state of the detector, after which the detector 
lamp will turn off if a start signal has not been received from the keypad or external Run 
(Input) terminal. Allowable values range from 0:30 to 9:59 hours. Default is 1:00.

To File (UV2000 only) This field, along with the Copy File field, allows you to copy a file to 
the specified file identification. 

W Lamp Hours This field tracks the total number of hours the detector's tungsten lamp has been in 
operation (up to 9999). When a new lamp is installed, you must set this parameter to 
zero.

Table 2. Menu Reference  (Sheet 6 of 7)
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Wavelength Program This command allows you to access the Wavelength Program. See the Time, 
Wavelength for details.

Zero (UV2000 only) This field appears in the Status Screen when the Scan file is loaded. To 
initiate a background scan, move the cursor to this selection and press ENTER. 

Zero on λ Change This field toggles between Yes, where the detector baseline automatically zeroes at each 
timed event during a programmed run, and No. Default is Yes.

Table 2. Menu Reference  (Sheet 7 of 7)
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8

Troubleshooting

This chapter provides you with helpful information for troubleshooting possible detector and 
chromatographic system problems. 

Theory of Operation
This brief theory of operation is included to aid you in troubleshooting problems and 
performing maintenance for your detector. For more detailed information, contact your 
Thermo Fisher Scientific representative.

Figure 112 shows the optical system. The detector operates in a double-beam mode using a 
fiber-optic beam-splitter that creates sample and reference beams. The reference beam is 
directed to a reference photodiode. The sample beam is lens-focused prior to passing through 
the flowcell to a sample photodiode.

An analog PCB processes the signals from the photodiodes and provides analog output signals 
through an 8-pin external connector. The digital PCB contains the EPROM (the built-in 
software), provides digital processing circuitry, and interfaces with the keyboard/display and 
the remote communications devices. (Additional software is held on an EPROM PCB.) The 
Motherboard provides all the necessary interconnections and power supplies.

Contents

• Theory of Operation

• Common Problems

• Error Messages

• Diagnostic Tests
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Figure 112. The optical system for the UV2000 detector

The deuterium and tungsten lamps are continuum light sources that provide high light 
intensity over the UV and visible wavelength ranges. Two sets of baffles minimize stray light. 
A concave holographic grating actuated by a microprocessor-controlled stepper motor 
provides wavelength selection.
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Common Problems
This next section contains a table of symptoms, possible causes, and remedies for some 
common problems you might observe in detector response. Many of the problems attributed 
to the detector might actually be due to other components in the chromatographic system, so 
we have included references to these types of problems and solutions as well.

Table 3. Troubleshooting Table  (Sheet 1 of 4)

Symptom Cause Remedy

1. Spikes on baseline. a. Gas bubbles in the flowcell. a. Degas mobile phase. Supply 
backpressure device to flowcell (check 
back-pressure rating). Check for leaks at 
high-pressure fittings.

b. Immiscible solvent bubbles 
following mobile phase 
changeover.

b. Flush flowcell with 2-propanol, then 
with mobile phase.

c. Electrical interference. c. Check electrical lines for good 
connections and/or interference from 
broadcast radiation. Check for ground 
loops.

d. Extremely large fluctuations in 
voltage on AC line.

d. Remove systems (for example, ovens) 
that cause voltage fluctuations, isolate 
the detector to "quiet" circuit, or use 
UPS (UPS, uninterruptible power 
supply).
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2. Random noisy baseline. a. Contaminated flowcell. a. Flush flowcell with cleaning solvents as 
described in “Cleaning the Flowcell” on 
page 75.

b. Leak in sample inlet line. b. Check all fittings from column outlet to 
flowcell inlet for leaks.

c. Bubble trapped in flowcell. c. Increase flow rate until bubble is 
removed. Supply backpressure device to 
flowcell (check back-pressure rating to 
avoid rupturing flowcell).

d. Leaking flowcell. d. Replace flowcell.

e. Insufficient lamp warm-up. e. Allow a 30 minute warm-up for normal 
operation; one hour for maximum 
sensitivity.

f. Lamp aging or defective. f. Replace lamp.

g. Ground loop problem between 
integrator and detector.

g. Check for proper cable connections for 
detector output; do not ground at both 
ends of cable.

h. Flowcell, lamp, lenses, or 
photodiode dirty.

h. Clean dirty component as described in 
“Cleaning the Flowcell” on page 75.

i. Integrator input voltage does 
not match detector output 
voltage.

i. Connect integrator to appropriate 
output connectors on detector (see 
Chapter 6, “Installation and 
Specifications.” ). Check attenuation 
setting on integrator.

Table 3. Troubleshooting Table  (Sheet 2 of 4)

Symptom Cause Remedy
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3. Excessive baseline drift. See 
Baseline problems.

a. Flowcell contaminated. a. Flush flowcell with cleaning solvents as 
described in “Cleaning the Flowcell” on 
page 75. Check for leaks.

b. Mobile phase contamination. b. Replace with fresh mobile phase made 
with high-purity solvents.

c. Material bleeding from column. c. Clean or replace column.

d. Leaks in system, or flowcell. d. Check all fittings for leaks. Replace 
flowcell.

e. Tiny bubble trapped in flowcell. e. Increase flow rate until bubble is 
removed. Connect backpressure device 
to flowcell outlet (check backpressure 
rating to avoid rupturing flowcell).

f. Large temperature fluctuations. f. Remove system from drafts. 
Thermostatically control column 
temperature.

4. No peaks, or peaks much 
smaller than expected.

a. Incorrect wavelength setting. a. Check wavelength setting. Make sure 
the correct file is selected.

b. Lamp not on or defective. b. Make sure lamp is lit. Run detector's 
diagnostic tests to check lamp. Replace 
lamp if necessary.

c. Integrator input voltage does 
not match detector output 
voltage.

c. Connect integrator to appropriate 
output connectors on detector (see 
Chapter 6, “Installation and 
Specifications.” ). Check attenuation 
setting on integrator.

d. Insufficient sample reaching the 
detector.

d. Check entire chromatographic system 
for leaks. Verify sample injection 
volume.

5. Broad, tailing peaks. a. Rise time is too large (too slow). a. Lower the rise time selection.

b. Flowcell volume too large. b. Change to a flowcell with smaller 
volume.

6. Clicking sound when 
UV2000 is in 
dual-wavelength mode.

a. Noise comes from grating 
motor, and is normal.

a. No action necessary.

Table 3. Troubleshooting Table  (Sheet 3 of 4)

Symptom Cause Remedy
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Error Messages
There are three types of error messages that you might see on your detector's display:

• System errors

• Real-time errors

• User-Input Errors

Each type of error is explained below in further detail.

System errors

System errors are indicated on the display by a double set of exclamation points (!!   !!). They 
occur whenever an undesirable condition exists that prevents the detector from operating. If 
one of these messages appears, try turning the detector's power switch off and on. If the 
message recurs, contact your Thermo Fisher Scientific representative.

• SYSTEM RESET

• RAM ERROR

• ADDRESS ERROR

• BUS ERROR

• DIVIDE BY ZERO

• LOW L0 ERROR

• LOW L1 ERROR

• DISTANT QUEUE ERROR

7. Detector won't power up. a. Tripped circuit breaker at AC 
wall outlet.

a. Resolve problem, reset circuit breaker.

b. Blown detector fuse. b. Resolve problem, replace fuse.

c. Incorrect voltage selected. c. Reset detector for correct incoming 
line-voltage (see Chapter 6, “Installation 
and Specifications.” ).

d. Power cord not connected. d. Connect power cord.

Table 3. Troubleshooting Table  (Sheet 4 of 4)

Symptom Cause Remedy
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Real-time errors

Real-time error messages indicate that you need to correct a certain hardware condition. 
Possible messages are: 

Error messages Description

Lamp Cover Open Check that the detector's lamp housing is in place and 
properly installed.

Low Light Detected From 
Deuterium Lamp

This message indicates that the deuterium lamp might 
not be on, might be improperly installed, or needs to be 
replaced due to low light energy. It can also appear if the 
lamp cover is replaced while the lamp is on.

Using the Lamps Menu (see “Automatic Lamp 
Operations” on page 43), turn the lamp state to off, wait 
five seconds, and then switch the lamp on. If the error 
message recurs, check for proper lamp installation 
according to the procedure outlined in Chapter 6, 
“Installation and Specifications.” 

If the lamp is installed correctly, its surface is clean, and 
the message still appears, replace the lamp.

Low Light Detected From 
Tungsten Lamp

This message indicates that the tungsten lamp might not 
be on, might be improperly installed, or needs to be 
replaced due to low light energy.

Using the Lamps Menu (see“Automatic Lamp 
Operations” on page 43), turn the lamp state to off, wait 
five seconds, and then switch the lamp on. If the error 
message recurs, check for proper lamp installation 
according to the procedure outlined in Chapter 6, 
“Installation and Specifications.” 

If the lamp is installed correctly, its surface is clean, and 
the message still appears, replace the lamp.
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User-Input Errors

The following error messages indicate improper use of the detector's menu system.

Error messages Description

A File Is Already Running You cannot start a different file while a file is already 
running.

Invalid Parameters, Spectrum Not 
Allowed

Invalid scanning setup parameters have been entered, 
so the detector cannot perform a spectral scan.

No More Available Memory All available system memory is full.

No Queue Available (UV2000) You cannot load a queue if none has been set up first. 

No Spectra Available (UV2000) You cannot run Replay Spectra when no spectra are 
available in memory. 

Protected File, Cannot Be 
Copied To (UV2000)

You cannot copy to a protected file. 

Protected File, Cannot Be Deleted
(UV2000)

You cannot delete a protected file. 

Protected File, Cannot Be Edited
(UV2000)

You cannot modify a protected file. 

Queue Loaded, Cannot Load File
(UV2000)

When a queue is loaded, you cannot load any other 
file. 

Run In Progress, Testing Not 
Allowed

You cannot run the detector's built-in diagnostics 
while a run is in progress.

Run Not In Progress, No Scanning 
Allowed (UV2000)

A spectral scan can only be performed when a run is 
in progress. 

Detector Shutdown This message occurs when you use the Shutdown 
Detector field to turn off the detector. (See 
“Shutdown Detector” on page 47) Press any key on 
the keypad to turn on the detector.

Scan Memory Full (UV2000) This message occurs when the Scan File is loaded and 
the scan data memory storage is full. 

Run In Progress, No Replay 
Allowed (UV2000)

The UV2000 does not allow you to replay stored 
spectral scans when the Scan file is loaded and a run 
is active. 
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Diagnostic Tests
This section describes the internal diagnostic tests supplied with your detector. It also 
references two external tests that you can run. Use these tests if you suspect that your detector 
is not working properly.

Internal Diagnostic Tests

To access the detector's internal diagnostic tests 

1. Press [MENU].

2. Select /TESTS/.

3. The Tests menu appears in Figure 113.

Figure 113. Detector's Tests Menu

Software Version

Select this field to display the EPROM version of your detector's software Figure 114.

Figure 114. The software version

Light Levels

The Light Levels test displays numbers related to the level of light intensity seen by the sample 
and reference photodiodes. When you select /Light Levels/, the screen in Figure 115 appears.

Figure 115. The Light Levels screen

The sample (S1, S2) and reference (R1, R2) numbers can differ considerably between 
instruments. A five- or six-digit number is typical. If you get an unusual reading, check the 
photodiodes and the analog PCB. These components are the ones that are the most likely to 
affect light intensity. If any of the numbers is zero, call Thermo Fisher Scientific.
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Diode Offsets

The Diode Offsets test presents numbers related to the level of background signal received 
from the sample and reference photodiodes when the lamps are off (dark current). When you 
select Diode Offsets, the screen in Figure 116 appears.

Figure 116. The diode offsets screen

The sample (S1, S2) and reference (R1, R2) numbers can vary considerably between 
instruments. A three- or four-digit number is typical. As with the Light Levels test, check the 
photodiodes and the analog PCB, the components most likely to affect light intensity, if you 
get an unusual reading. If any of the numbers are zero, call Thermo Fisher Scientific.

To recalculate the diode offsets, select C. The offsets might need to be recalculated if the light 
levels are less than the diode offsets. This situation normally occurs after slight diode offset 
drift or while working with extremely low light.

λ Calibration

Selecting /λ Calibration/ brings up the screen shown in Figure 117. You can use this screen 
(in combination with the optional Cuvette Holder Accessory) to offset the factory-calibrated 
wavelength to more closely match an FDA, industry, or in-house calibration standard.

Figure 117. The lambda offset screen
 

To offset the factory-calibrated wavelength, select the number of "steps" by which you want 
the wavelength to be offset. Each step represents approximately 0.25 nm, so if you choose "2" 
for the number of steps, you will have offset the wavelength by +0.5 nm. You can offset the 
wavelength by as much as 2.5 nm.

Note  If you want to conduct your calibration using the Cuvette Holder, the following 
procedure has also been detailed in Appendix E for your convenience.

Note  The UV2000 detector is calibrated using a mercury lamp fixture. This provides a 
very narrow emission line at 254 nm. Broad-band calibration standards, such as holmium 
oxide and didymium filters, make calibration more difficult and less accurate.

Note  The offset value is not cleared upon resetting the RAM memory. It can only be 
changed from the lambda offset screen.
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Self-Tests

The detector automatically runs eight internal diagnostic tests when it is powered up. To run 
the tests at any other time, select /Self-Tests/. 

If any test (other than the two lamp tests) fails, you'll see a message to that effect on the 
display. Clear the message and run the remainder of the self-tests by pressing ENTER. Repeat 
this process as many times as necessary until all self-tests are completed and the Status Screen 
appears. If any test has failed, the Status Screen will read "NRDY" (Not Ready).

Although you can frequently get back to the Ready state on your own (for example, you can 
manually turn on the lamps from the Options Menu, or load a file), the detector might not 
function properly and your results might be affected. For this reason, and to help you 
troubleshoot the detector on your own, we have listed the MLF (most likely failure) for each 
test. Problems that are not readily resolved should be referred to your Thermo Fisher 
Scientific representative.

The eight self-tests are:

1. RAM. This test checks both non-volatile and volatile RAM with a read/write test. The 
"Testing RAM" message only appears during self-initiated testing. On power-up, the test 
occurs without any special message. A failure during either type of testing is indicated by 
the messages "Bad DRAM" or "Bad NOVRAM." MLF: Digital PCB.

2. Voltages. This test checks the circuitry-supply voltages. MLF: Motherboard.

3. Analog Outputs. This test checks the scale and linearity of the output signal 
(recorder/integrator). Failure is indicated by a "Fail" or a "Bad Analog Linearity" message. 
MLF: Analog PCB.

4. Diode Offsets. This test checks the diodes (photodiodes) with the lamp(s) off (dark 
current). Either a "Bad Sample Diode" or an "Intense Light Detected" message indicates 
failure. You should verify that the sample photodiode is fastened securely to the flowcell 
and that light is actually passing through the flowcell. If "Fail" or a "Bad Ref. Diode 
Detected" appear, call your Thermo Fisher Scientific representative. MLF: Photodiode or 
Analog PCB.

5. Motor. The Motor Test checks the monochromator motor and its voltages. MLF: Motor.

6. Deuterium Lamp. This test checks the D2 lamp and its voltages when the lamp is on and 
when it is off. If the message "D2 Not Detected" appears, the lamp voltages are good, but 
the lamp is either not present or not functioning properly. Try replacing the deuterium 
lamp and retrying the test. If the word "Fail" appears, call your Thermo Fisher Scientific 
representative. MLF: Lamp or Motherboard.

7. Tungsten Lamp. This test checks the W lamp and its voltages when the lamp is on and 
when it is off. If the message "W Not Detected" appears, the lamp voltages are good, but 
the lamp is not present or is not functioning properly. Try replacing the tungsten lamp 
and retrying the test. If the word "Fail" appears, call your Thermo Fisher Scientific 
representative. MLF: Lamp or Motherboard.
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8. Lamp and Shutter. This UV2000 test actually has several parts, each of which checks a 
different part of the lamps' and shutter's operation. If either of the lamps fails, an 
appropriate message will be displayed. Try replacing the lamp and retrying the test. If a 
"Bad Shutter" message appears, call your Thermo Fisher Scientific representative. MLF: 
part listed on display.

External Diagnostic Tests

This section describes two external diagnostic tests that can be used to verify that your 
detector is working properly.

Checking the Chromatogram Produced by Injecting LC Test Mix

An ampule of prepared LC Test Mix is included as part of your detector's accessory kit. An 
instruction sheet describing the parameters for running the test mix and showing the resulting 
chromatogram is also enclosed. This is a good test to run when you first set up your LC 
system.
 

Absorbance Linearity

Use the optional cuvette holder (see Chapter 9, “Cuvette Holder Accessory,” ) and certified 
standards to test the absorbance linearity of your detector in the UV range (approximately 
235 nm to 350 nm). For your convenience, the following procedure is also detailed in 
Chapter 9, “Cuvette Holder Accessory.” 
 

To perform the test, you will need procedure E 925 from the American Society for Testing 
and Materials (ASTM) and standard potassium dichromate (SRM 930) from the National 
Institute of Standards and Technology (NIST; formerly the National Bureau of Standards, 
NBS). The test involves the preparation of acidic solutions of potassium dichromate at four 
concentrations and the absorbance measurement of each solution at four wavelengths between 
235 and 350 nm. After correcting for an absorbance blank, the linearity deviation of a plot of 
absorbance versus concentration should be less than 1%.

If you want more information on this test, or find that your instrument does not conform to 
these specifications and requires service, contact your local Thermo Fisher Scientific 
representative.

Tip  Keep the chromatogram that you generate with the LC Test Mix. It can be a useful 
baseline for troubleshooting problems later on.

Tip  This procedure is particularly useful for laboratories that require periodic detector 
validation.
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9

Cuvette Holder Accessory

This Chapter provides information on the installation, use, and maintenance of the 
Cuvette Holder Accessory (Figure 118). This accessory is available to simplify 
calibration/standardization of your UV2000 UV/Vis detector using FDA, industry, or 
in-house calibration standards. The cuvette holder is a modular accessory that installs in place 
of the detector flowcell. It allows analysis of calibration standards (for example, potassium 
dichromate) to ensure your detector's compliance with FDA, industry, and/or in-house 
regulations.

To use the cuvette holder, prepare your calibration standard according to the instructions 
provided with the sample. Then place the sample in a standard 10.0 mm I.D. 
(12.5 mm O.D.) quartz cuvette. Analyze the sample and compare its measured maxima to its 
certified maxima. If there's a discrepancy in the measured wavelength, the detector can be 
recalibrated using the procedure described on “λ Calibration” on page 120. 

Figure 118. Cuvette Holder accessory

Mounting screws

Photodiode
standoffs

Cuvette
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Installation
The cuvette holder attaches to your detector using the standard flowcell mounting hardware.

To remove the flowcell and install the cuvette holder

1. Remove the front panel of the detector (Figure 119) to gain access to the flowcell 
mounting area. Note that the front panel is a friction-grip mount and will snap free if you 
pull outward on its lower edge.

2. Remove the thumbscrew that secures the flowcell cover to the front of the detector 
(Figure 120). Remove the flowcell cover and set it aside.

3. Remove the two thumbscrews that secure the photodiode assembly to the front of the 
flowcell (Figure 121) and then reposition the photodiode assembly out of the way to 
provide access to the flowcell.

4. Remove the two thumbscrews (top left, lower right) that secure the flowcell mount 
(Figure 122) to the front of the detector and then remove/reposition the flowcell.

5. Position the cuvette holder and secure the two thumbscrews (at top left and lower right) 
that secure the holder to the threaded holes on the detector's front panel.

6. Replace the photodiode assembly and secure it to the cuvette holder's standoffs with its 
two thumbscrews (at top right and lower left).

7. Snap the detector's front panel back in place.

Tip  You needn't disconnect the flowcell's tubing connections to your LC system if the 
cuvette holder is only going to be used long enough to conduct a calibration. Simply 
reposition the flowcell and omit Step 7 of this procedure.
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Figure 119. Detector front panel
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Figure 120. Detector with front panel removed to expose flowcell housing

RUN

STOP

MENU

E N T E RENTER

ZERO UV2000SpectraSYSTEM

STATUS

Flowcell housing



 9 Cuvette Holder Accessory
Installation

Thermo Scientific SpectraSYSTEM UV/Vis Detectors User Guide 127

Figure 121. Detector with flowcell assembly exposed to show photodiode assembly-mounting 
thumbscrews
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Figure 122. Detector with photodiode assembly repositioned to expose flowcell
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Using the Cuvette Holder
The two procedures that follow allow you to use the Cuvette Holder to test the linearity of 
your detector's absorbance and to recalibrate the detector, if necessary.

Absorbance Linearity

You can use the optional Cuvette Holder and certified standards to test the absorbance 
linearity of your detector in the UV range (approximately 235 to 350 nm).

To perform the test, you'll need procedure E 925 from the American Society for Testing and 
Materials (ASTM) as well as standard potassium dichromate (SRM 930) from the National 
Institute of Standards and Technology (NIST; formerly the National Bureau of Standards, 
NBS). The test involves the preparation of acidic solutions of potassium dichromate at four 
concentrations and the absorbance measurement of each solution at four wavelengths between 
235 and 350 nm. After correcting for an absorbance blank, the linearity deviation of a plot of 
absorbance versus concentration should be less than 1%. 

If you want more information on this test, or find that your instrument does not conform to 
these specifications and requires service, contact your local Thermo Fisher Scientific 
representative.

λ Calibration

Selecting /λ Calibration/ brings up the screen shown in Figure 123. You can use this screen to 
offset the factory-calibrated wavelength to more closely match FDA, industry, or in-house 
standards.

Figure 123. The lambda (wavelength) offset screen

IMPORTANT  Be sure to insert the cuvette inside the holder so that its transparent sides 
(rather than the frosted ones) are in line with the beam of light from the detector's lamp. 
Failure to insert the cuvette properly might result in insufficient light levels for accurate 
analyses.

Tip  This procedure is particularly useful for laboratories that require periodic detector 
validation.

Tip  The UV2000 detector is calibrated using a mercury-lamp fixture. This provides a very 
narrow emission line at 254 nm. Broad-band calibration standards, such as holmium 
oxide and didymium filters, make calibration more difficult and less accurate.
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To offset the factory-calibrated wavelength, select the number of "steps" by which you want 
the wavelength to be offset. Each step represents approximately 0.25 nm, so if you choose "2" 
for the number of steps, you will have offset the wavelength by + 0.5 nm. You can offset the 
wavelength by as much as ±2.5 nm.

Maintenance
The cuvette holder contains no user serviceable components; however, cleanliness of the 
cuvettes is critical to obtaining accurate analyses. Therefore, these instructions are provided 
for inspecting and cleaning the cuvettes. 

Inspecting a Cuvette

Cuvettes, whether previously used or new, should always be visually inspected before use. 

To inspect a cuvette

1. Grasp the cuvette by its two frosted sides and hold it up in front of a bright light source 
such as a fluorescent fixture, incandescent bulb, or sunny window.

2. Carefully observe the cuvette's two transparent glass sides. Look for physical damage such 
as chips, cracks, scratches, etc. Also look for dirt, smudges, fingerprints, and so forth.

3. Based on the results of your inspection, you can do one of the following three things:

a. If no optical-surface damage or contamination is noted, fill the cuvette with sample 
and use it for your analysis.

b. If you see physical damage or severe contamination on the optical surfaces, replace 
the cuvette with a new one.

c. If no physical damage is noted and only light to moderate contamination, clean the 
cuvette using the procedure in Cleaning a Cuvette.

IMPORTANT  The offset value isn't cleared upon resetting the RAM memory. It can only 
be changed from the lambda offset screen.
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Cleaning a Cuvette

If the visual inspection reveals contamination of or damage to the cuvette's optical surfaces 
(the inner and/or outer surfaces of the cuvette's two transparent faces), then the cuvette 
should be cleaned before use. 

To clean a cuvette

1. Immerse the cuvette in a small beaker filled with an appropriate cleaning solution. Use 
detergent and water to clean cuvettes that are contaminated with residue from 
water-based solutions. Use an appropriate organic solvent (for example, methanol, 
ethanol, isopropanol, and so on) for cuvettes contaminated with residue from 
organic-solvent-based samples.

2. Place the beaker containing the cuvette(s) and cleaning solution in an ultrasonic bath and 
set the timer. Use a time setting that's appropriate for the amount of contamination that 
has to be removed.

3. Remove the cuvette from the beaker, handling it by its frosted sides only. Rinse it 
thoroughly with clean deionized water until all traces of detergent and dirt have been 
flushed away.

4. Dry the cuvette thoroughly with a lint-free wiper, exercising care to handle the cuvette 
only by its two frosted (non-optical) sides.

5. Carefully inspect the cuvette for residual contamination using the steps detailed in the 
preceding section of this appendix. If any is noted, repeat Steps 1 through 4 until the 
cuvette is completely clean and dry.

Tip  In cases of serious contamination that resists removal, it might be easier to replace a 
dirty cuvette than to spend a lot of time cleaning it.
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A

List of Spare Parts, Consumables, and Kits 

Shown below is a list of spare parts and consumables available from Thermo Fisher Scientific 
for use with your SpectraSYSTEM UV/Vis detector. Contact your local Thermo Fisher 
Scientific representative for current prices.
Flowcells

9550-0100 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Analytical LC (6 mm)
9550-0234 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Analytical LC (10 mm)
9550-0053 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Microbore (3 mm)
9550-0265 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Microbore (6 mm)
9550-0101 . . . . . . . . . . . . . . . . . . . . . . . . . . . Semi-preparative, Open Column (3 mm)
9550-0263 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Cuvette Cell Holder

Options And Accessories
2103-9119 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . External Events Connector
A4095-010 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Remote Interface Cable
9551-0022 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Tungsten Lamp, prealigned
9551-0023 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Deuterium Lamp, prealigned
9051-0143 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Regulated Backpressure Accessory

Manuals
A0099-64001 . . . . . . . . . . . . . . . . . . . . . . . . . . . . SpectraSYSTEM documentation CD

Maintenance Parts
A4051-010 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Standard Fittings Kit

(Kit includes stainless steel fittings and tubing used in a SpectraSYSTEM LC system.)
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bandwidth specification  97
baseline

zeroing during a run  42
baseline drift, troubleshooting causes of  115
baseline noise

minimizing  28
brackets  7

C
chronometer, deuterium lamp  78
co-eluting peaks  63
common problems  113
confirmation messages  6
conventions in this manual  6
Current Time field  44
cursor speed, setting  47
cuvette holder accessory  123

D
deuterium (D2) lamp  43

diagnostics self-test  121
installing  80
removing  78

Develop Files
description of  56
editing  56
running  57
selecting  56

diagnostic detector self-tests  121
diagnostic tests  119
diode offsets, diagnostics self-test  121
diode offsets, testing  120
display screen

conventions  6
setting the contrast  46

drift specification  97

E
Enter key  4
environmental requirements  97
erratic baseline caused by a dirty flowcell  75
error messages  6
errors

real-time  117
system  116
user-input  118

Index
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Index: F

event mark  46
exclamation points, double set of  116

F
file identification  27
files

loading  16, 29
protecting  33
saving  31
Scan file  49

flowcells
alignment  95
changing  71
cleaning  75
connecting  93
installing  74
optional  94
pushing solvents through  75
removing  73

fuses, changing  88

G
gas bubbles in the flowcell  113
grating motor, noisy  115
ground loops  113

H
humidity, environmental requirement  97

I
initial time entry for a wavelength program  40
installation checklist  83
integrator, attenuation setting  114

K
keypad  3
K-factor

description  63
using  66

L
lambda max  51
lambda min  52
lamp and shutter, diagnostics self-test  122
Lamp field  43
lamp hours  43
lamps

aging of  77

location  77
warmup  17

Lamps Menu  43
LC test mix, using  122
light levels, testing  119
lines

deleting from the queue  59
entering into the Queue  59

locking the Status Screen  45
low light error message  117

M
maintenance procedures

changing the fuses  88
cleaning the cuvette holder  131
cleaning the flowcell  75
inspecting the cuvette holder  130
replacing the deuterium lamp  78
replacing the tungsten lamp  80

maxima, wavelength  51
Menu key  4
menu reference (UV1000 and UV2000)  103
menu tree

UV1000  100
UV2000  101

menus  4
mercury-lamp fixture  129
motor, diagnostics self-test  121

N
nitric acid, cleaning the flowcell with  76
noise specification  97
noisy baseline, troubleshooting causes of  114
noisy grating motor  115
NRDY status  17

O
one-line wavelength program  27
operation

UV1000  20
UV2000  26

operation, theory of  111
optical system  112
optimizing the detection wavelength  56
Options menu  28
Order field  59
overlapping peaks  63
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Index: P

P
parameters, setting  26
peak purity, determining  68
peak tailing  115
peak width, setting the rise time  28
photodiode mount  73
potassium dichromate solution  129
power requirements  97
Program field  27
programming

in the Files Menu  30
in the Status Menu  30

Q
Q in the Status Screen  60
Queue Menu  59
queues

deleting or stopping  62
editing  61
loading  60
pausing  62
running  60

R
RAM diagnostic self-test  121
range selection for an integrator or data system  28
range, setting  16
ratios, absorbance  68
Ready output signal  46
Ready status  17
Ready terminal  92
rear panel connections  89
recorded scan data, overwriting  55
remote communications connections  91
replay

running  54
stopping  55

Replay Menu  53
replaying a spectral scan  53
rise time  28
run

starting  30
stopping  30

Run key  3
Run terminal  91

S
scan files

running  50

selecting  49
setting up  49
stopping  52

scan files, replaying  53
Scan Summary Data Screen  51
Scan Zero Time field  53
scanning feature  48
select, convention used in this manual  7
short outputs  45
Shutdown Detector field  47
signal spiking, caused by a dirty flowcell  75
slashes  7
software version, displaying  119
solvents

cleaning the flowcell with  75
cleaning the flowcell with nitric acid  76

specifications for the UV2000 detector  97
spectral data

storing  55
viewing  55

spikes on baseline  113
startup  14
Startup and Shutdown fields  44
Status key  3
Status Menu  5, 31
Status Screen  5, 29
Stop key  3
stop lines in a wavelength program  40
Stop terminal  91
stop time

adding  17
using  18

subtracting absorbances  63

T
temperature, environmental requirement  97
Time from READY feature  44
time lines

adding to a wavelength program  40
deleting from a wavelength program  40

tungsten (W) lamp
diagnostics self-test  121
installing  81
Lamps Menu  43
removing  80

two-line wavelength program  27

U
uninterruptible power supply (UPS)  113
unpacking  85
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Index: V

Unshort Outputs selection  46
user messages  5
UV1000

analog outputs  35
basic operation  20
features  9
getting started  10
menu tree  100

UV2000
analog outputs  36
basic operation  26
features  9
getting started  14
menu tree  101

V
voltage fluctuations  113
voltages

diagnostic self-test  121
selection  86

W
warm-up time specification  114
wavelength

optimizing  56
setting  15

wavelength accuracy and precision  97
wavelength calibration using a mercury-lamp fixture  129
wavelength calibration, testing  120
wavelength minima  52
wavelength program

accessing  27
building  39

weight of the detector  97

Z
Zero key  4
zero on wavelength change  42
Zero terminal  91
zeroing

the background absorbance  50
the baseline during a run  42
the detector signal  30


	Contents
	Preface
	About This Guide
	Safety and Special Notices
	Contacting Us

	Introduction
	Learning Your Way Around
	Visual Clues

	Instrument Control
	Keypad
	Menus, Screens, and Messages

	Manual Conventions
	Displays
	Text
	Standard Words

	What's Next?

	Quick Example
	UV1000 Example
	Startup
	Setting Parameters
	A Practice Run
	Adding a Stop-Time
	Running with a Stop-Time

	UV2000 Example
	Startup
	Setting Parameters
	A Practice Run
	Adding a Stop-Time
	Running with a Stop-Time

	What's Next?

	Basic Operations
	UV1000, Single-Wavelength Operation
	Setting Parameters
	Running Your Detector
	Changing Run Parameters
	Deleting the File

	UV2000, Single- and Dual-Wavelength Operation
	Setting Parameters
	Loading a File
	Running Your Detector
	Changing Run Parameters
	Status Menu
	Saving the File

	More About UV2000 Files
	Copying Files
	Deleting Files
	Protecting Files

	UV1000 Analog Signals
	Analog Outputs
	Analog Offsets

	UV2000 Analog Signals
	Analog Outputs
	Analog Offsets


	Advanced Operations
	Wavelength Programming
	Building the Program
	Running the Program

	Programmed Autozero
	Automatic Lamp Operations
	The Lamps Menu

	Other Features
	Status Lock
	Short Outputs
	Event Mark
	Ready Output
	Display Contrast
	Cursor Speed
	Shutdown Detector

	Scanning (UV2000)
	How It Works
	Selecting the Scan File
	Setting Up the Scan File
	Running the Scan File
	Stopping the Scan File

	Automatic Scanning (UV2000)
	Replaying Your Spectra
	Spectral Data Storage

	The Develop File (UV2000)
	Selecting the Develop File
	Editing the Develop File
	Running the Develop File
	Repeating the Develop File

	Sample Queue (UV2000)
	Queue Menu
	Setting Up a Queue
	Loading a Queue
	Running a Queue
	Editing a Queue
	Pausing a Queue
	Deleting / Stopping a Queue

	K-Factor (UV2000)
	Absorbance Ratios (UV2000)

	Required Maintenance
	Flowcells
	Changing the Flowcell
	Cleaning the Flowcell

	Lamps
	The Deuterium Lamp
	The Tungsten Lamp


	Installation and Specifications
	Installation Checklist
	Unpacking
	Checking the Power
	Voltage Selection
	Fuses
	Power Cord

	Making Rear Panel Connections
	UV2000 Analog Output Connections
	UV1000 Analog Output Connections
	Remote Communications Connections

	Connecting to the Flowcell
	Optional Flowcells
	Flowcell Orientation

	Specifications

	Menu Reference
	Menu Trees
	Menu Reference

	Troubleshooting
	Theory of Operation
	Common Problems
	Error Messages
	System errors
	Real-time errors
	User-Input Errors

	Diagnostic Tests
	Internal Diagnostic Tests
	External Diagnostic Tests


	Cuvette Holder Accessory
	Installation
	Using the Cuvette Holder
	Absorbance Linearity
	l Calibration

	Maintenance
	Inspecting a Cuvette
	Cleaning a Cuvette


	List of Spare Parts, Consumables, and Kits
	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /CMYK
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


